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The information in this document is current as of July, 2001. The information is subject to change 
without notice.  For actual design-in, refer to the latest publications of NEC's data sheets or data 
books, etc., for the most up-to-date specifications of NEC semiconductor products.  Not all products 
and/or types are available in every country.  Please check with an NEC sales representative for 
availability and additional information.
No part of this document may be copied or reproduced in any form or by any means without prior       
written consent of NEC.  NEC assumes no responsibility for any errors that may appear in this document.
NEC does not assume any liability for infringement of patents, copyrights or other intellectual property rights of 
third parties by or arising from the use of NEC semiconductor products listed in this document or any other 
liability arising from the use of such products.  No license, express, implied or otherwise, is granted under any 
patents, copyrights or other intellectual property rights of NEC or others.
Descriptions of circuits, software and other related information in this document are provided for illustrative 
purposes in semiconductor product operation and application examples. The incorporation of these 
circuits, software and information in the design of customer's equipment shall be done under the full 
responsibility of customer. NEC assumes no responsibility for any losses incurred by customers or third 
parties arising from the use of these circuits, software and information.
While NEC endeavours to enhance the quality, reliability and safety of NEC semiconductor products, customers 
agree and acknowledge that the possibility of defects thereof cannot be eliminated entirely.  To minimize 
risks of damage to property or injury (including death) to persons arising from defects in NEC 
semiconductor products, customers must incorporate sufficient safety measures in their design, such as 
redundancy, fire-containment, and anti-failure features.
NEC semiconductor products are classified into the following three quality grades:
"Standard", "Special" and "Specific".  The "Specific" quality grade applies only to semiconductor products 
developed based on a customer-designated "quality assurance program" for a specific application.  The 
recommended applications of a semiconductor product depend on its quality grade, as indicated below.  
Customers must check the quality grade of each semiconductor product before using it in a particular 
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 "Standard": Computers, office equipment, communications equipment, test and measurement equipment, audio
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(Note)
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INTRODUCTION

Readers: The project manager is control software that enables efficient control of programs

running in WindowsTM.   This manual is intended for user engineers who wish to develop

application systems using the project manager on Windows.

Purpose: This manual explains how to operate the project manager.  The manual is organized as

described below.

Organization: This manual consists of the following contents:

• Menu lists and buttons

• Functions

• Executing project manager

• Device file installer (DFINST)

• Message list

• Menu list

• List of project manager programs

How to Read This Manual: It is assumed that the readers of this manual have a general knowledge of

microcomputers and a basic knowledge of how to operate Windows 95, Windows 98,

Windows NTTM 4.0, and Windows 2000.

To find out the meaning and cause of a message

→ Refer to APPENDIX A MESSAGE LIST.

To understand the overall functions of the project manager

→ Read this manual in the order of CONTENTS.

Conventions: “ ”: Indicates a character or item on screen.

 OK   : Indicates the name of a button.

[ ]: Indicates a menu.

< >: Indicates a dialog name.
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Related Documents: When using this manual, also refer to the following documents.  The related documents

indicated in this publication may include preliminary versions.  However, preliminary

versions are not marked as such.

Documents related to development tools (user’s manuals)

Document Name Document No.

Operation U14297ECC78K0 C Compiler Ver. 3.30 or Later

Language U14298E

Operation U14871ECC78K0S C Compiler Ver. 1.30 or Later

Language U14872E

Operation U11571ECC78K4 C Compiler Ver. 2.20 or Later

Language U11572E

Operation U14445ERA78K0 Assembler Package Ver. 3.50 or Later

Language U14446E

Operation U14876ERA78K0S Assembler Package Ver. 1.30 or Later

Language U14877E

Operation U11334ERA78K4 Assembler Package Ver. 1.30 or Later

Language U11162E

SM78K0S, SM78K0 System Simulator Ver. 2.10 or

Later Windows Based

Operation U14611E

SM78K Series System Simulator Ver. 2.30 or Later

Windows Based

Operation U15373E

SM78K Series System Simulator Ver. 1.40 or Later External Part User

Open Interface

Specifications

U10092E

ID78K0-NS Integrated Debugger Ver. 2.00 or Later

Windows Based

Operation U14379E

ID78K Series Integrated Debugger Ver. 2.00 or

Later Windows Based

Operation U15185E

Fundamentals U11537E78K/0 Series Real-Time OS

Installation U11536E

Fundamental U10603E78K/IV Series Real-Time OS

Installation U10604E
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CHAPTER  1   GENERAL

This chapter gives an outline of the project manager.

1.1   Product Overview

1.1.1   Overview

The project manager is software that is used to develop user programs for the NEC’s 78K Series of 8-/16-bit

microcontrollers for embedded control more efficiently.

This software supplies a program development environment in Windows 95, Windows 98, Windows NT 4.0, and

Windows 2000.  All operations used in development of a user program, such as starting the editor, building, and

starting the debugger, can be performed from the project manager.

1.1.2   Major functions

The major functions of the project manager are as follows:

(1) Starting editor

The project manager can be used to start an editor used for developing a program.  Although a standard editor

(idea-L) is supplied with the project manager, the user can also register and start an external editor from the

project manager.

(2) Starting a builder

The project manager can be used to start a compiler, structured assembler, assembler, linker, object converter,

and list converter.

(3) Starting a debugger

The project manager can be used to start NEC’s ID78Kx debugger and SM78Kx system simulator.

(4) Correcting a source and executing build by issuing instructions from a debugger

If code requiring correction is found during debugging, correction of the source can be initiated by the debugger.

After correction the source is built again and debugging is resumed.

(5) Calling other applications from the project manager by including them in the menu

Other applications the user often uses can be included in the menu of the project manager and started from this

menu.

(6) Saving status of each project

The project manager can save the status of settings and window to a file.  By reading this file, the previous status

can be restored and development of a user program can be resumed in that status.
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1.1.3   Positioning of project manager

Figure 1-1 shows the relationship between the software used for program development and the project manager.

Figure 1-1.  Relationship Between Software for Program Development and Project Manager
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1.1.4   Operating environments

The hardware and software environments necessary for using the project manager are as follows:

(1) Hardware environment

(a) Host machine

• PC-9821 series

• PC98-NX series

• IBM PC/ATTM or compatibles

(b) CPU

• 80486SX or above



CHAPTER  1   GENERAL

User’s Manual  U15636EJ1V0UM 15

(c) Memory

• 8 MB MIN with Windows 95 (12 MB or more is recommended.)

• 16 MB MIN with Windows 98 (20 MB or more is recommended.)

• 16 MB MIN with Windows 2000 (20 MB or more is recommended.)

• 16 MB MIN with Windows NT 4.0 (20 MB or more is recommended.)

(2) Software environment

(a) OS

• Windows 95, Windows 98, Windows NT 4.0, Windows 2000

(b) Device file

• Device file of target device used

1.2   Installing Project Manager

The project manager is included with an assembler package (RA78Kx).  When the assembler package is installed,

the project manager is also installed.

For details on how to install the assembler package, refer to RA78Kx Assembler Package Operation User’s

Manual.

The project manager is installed to the directory \Nectools32\bin on the drive where Windows is installed by

default.  The default registration group is NEC Tools 32.
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1.3   Uninstalling Project Manager

This section explains how to uninstall the project manager.  In the explanation below, it is assumed that Windows

has been installed in directory “A:\WINDOWS”.

<1> Start up Windows.

<2> Click “Add/Remove Programs” in the Control Panel.

<3> Select the “Install/Uninstall” tab, select “NEC Project Manager V3.xx” from the list displayed, and click the

Add/Remove... button.
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<4> Then <Confirm File Deletion> dialog box will be displayed.  Click the  Yes  button.

<5> The following screen will be displayed.

<6> When the programs have been deleted and the message “Uninstall successfully completed” is displayed,

click the  OK  button.

This completes uninstalling the project manager.
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1.4   Starting and Exiting

1.4.1   Starting

The project manager is a Windows application.  Be sure to run this software after starting Windows.

[Starting project manager]

When the icon in the project manager group registered during installation is double-clicked, the following screen

will be displayed.  This is the start screen of the project manager.

Figure 1-2.  Start Screen of Project Manager

• Project window: Displays project names, source files, and include files in tree structure.

• Output window: Displays execution process of build.

Buttons

Output window

Menu

Project window
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1.4.2   Exiting

Exit from the project manager in the following two ways:

<1> Use the icon (close button) at the upper right on the screen.  Click the close button with the mouse.  The

screen will be closed.

Figure 1-3.  Exiting from Project Manger (Close Button)

<2> Select the [Exit] command from [File] menu.

Figure 1-4.  Exiting from Project Manager (Menu)

[Caution]

An application error may occur or dialog boxes may not be correctly displayed when the project manager is

started or while idea-L is used, if the version of Windows used is an early version or if the file comctl32.dll is out of

date.  If this is the case, update comctl32.dll by using the “comctl32.dll 4.72 installer” supplied with the project

manager.  To start this installer, double-click the icon in the project manager group registered when the project

manager was installed, or click [Start] on the Windows task bar, select [Program] → [Nectools32] from the menu, and

“comctl32.dll 4.72 installer”.

It is not necessary to update comctl32.dll if Microsoft Internet Explorer 3.x or later has been installed.

Close button
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CHAPTER  2   MENU  LIST  AND  BUTTONS

This chapter explains the menu list and buttons of the project manager.

2.1   Menu List

The project manager has the following menus:

(1) [File] menu

This menu is used to print information on the project and exit from the project manager.

This menu contains the following menu items:

• [Print]: Prints information on the current project.

Registers the type and attributes of the printer.

• [Exit]: Exits from the project manager.

For more details on the [File] menu, refer to 3.1 File.



CHAPTER  2   MENU  LIST  AND  BUTTONS

User’s Manual  U15636EJ1V0UM 21

(2) [Build] menu

This menu is used to correct build sources and start the debugger.

This menu contains the following menu items:

• [Build and Debug]: Successively executes build and debugging.

• [Edit]: Starts the editor that is used to edit source files.

Any commercially available editor can be used in addition to the standard editor

supplied with the project manager.

• [Compile]: Compiles one source file.

• [Build]: Executes build.

• [Stop Build]: Stops build.

• [Debug]: Starts the debugger that is used to debug programs.

• [Rebuild]: Forcibly builds all targets.

• [Build Option]: Specifies the final target.

Sets the PM options related to build.

Performs settings related to the debugger.

• [User-Registered Tool Title]: Executes a tool (custom tool) registered using <Tools...>.

Up to 10 tools can be registered.

Refer to Figure 3-25  Example of Custom Tool Menu.

For the details of this [Build] menu, refer to 3.2 Build.
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(3) [Project] menu

This menu is used to execute, maintain, and manage a project.

This menu contains the following menu items:

• [New]: Initializes the settings of the project and opens the setting dialog box for a new project.

• [Open]: Opens a specified project file and sets project information.

• [Save]: Saves the current setting information.

• [Save As]: Saves the current setting information to a specified file.

• [Close]: Closes the project.

• [Project Setup]: Sets information about a project.

• [Make a Make File]: Creates a make file used for build.  Usually, a make file is automatically created.

• [Project Name]: Starts the project displayed on the menu.  The nine most recent projects are displayed.

For more details on the [Project] menu, refer to 3.3 Project.
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(4) [Option] menu

This menu is used to set various options.

This menu contains the following menu items:

• [Tool Option Settings]: Sets the options of the structured assembler, assembler, linker, object converter,

and list converter.

For details of these options, refer to the RA78Kx Assembler Package Operation

User’s Manual.

• [Select Debugger]: If both a debugger and simulator are installed, this selects which of them is used

for debugging.

• [Tool]: Registers tools the user often uses.

• [Project Manager Options]:

Sets project manager options.

Hides or displays the status bar.

Hides or displays project windows such as the source list.

• [DeviceFile Installer]: Starts the device file installer.

For details of the [Option] menu, refer to 3.4 Options.
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(5) [Help] menu

This menu displays help information.

This menu contains the following menu items:

• [PM Help Topics…]: Displays the keyword of a help item.

• [About PM…]: Displays the current version of the project manager.

• [Tool Help]: Displays help for the assembler package and compiler.

The contents of this menu differ depending on the series.  Nothing may be displayed

depending on the series.

For the details of the [Help] menu, refer to 3.5 Help.
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2.2   Buttons

The project manager has the following buttons on its tool bar:

Table 2-1.  Buttons on Tool Bar (1/2)

Button Description

New project creation button.  Opens the <Create New Project> dialog box.

Project open button.  Opens the <Open> dialog box.

Save button. Saves the project information of the currently opened project file by overwriting this

file.

Print button. Opens the <Print> dialog box.

Make file creation button.  Specifies creation of a make file used for build.  Usually, a make file is

automatically created.

Build settings button.  Opens <Build Setup> dialog box.

Project settings button.  Opens <Project Setup> dialog box.

Setting of project manager options.  Opens <Project Manager Options> dialog box.

Tool (custom tool) registration button.  Opens <Tools> dialog box.

Compile button.  Compiles one source file.

Build button.  Executes build.

Rebuild button.  Forcibly builds all targets.

Build and debug button.  Successively executes build and debugging.

Build stop button.  Stops build.

Edit button.  Starts an editor for editing source files.

Structured assembler option setting button.  Opens <Structured Assembler Options> dialog box.

Assembler option setting button.  Opens <Assembler Options> dialog box.

Linker option setting button.  Opens <Linker Options> dialog box.

Object converter option setting button.  Opens <Object Converter Options> dialog box.

List converter option setting button.  Opens <List Converter Options> dialog box.
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Table 2-1.  Buttons on Tool Bar (2/2)

Button Description

Debugger selection button. When both a debugger and simulator are installed, this button is used to

select which to use for debugging.

Device file installer button. Starts the device file installer.

Help button.  Displays help.
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CHAPTER  3   FUNCTIONS

This chapter explains the functions of the project manager.

3.1   File

3.1.1   Print

[Function]

Prints the contents of the project file currently open.

[Explanation]

(1) When [Print] is selected, the following <Print> dialog box is displayed.

Figure 3-1.  <Print> Dialog Box
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(2) About <Print> dialog box

<1> “Number of Copies” specifies the number of copies to be printed.

<2> Only “All” can be selected for “Print range”.

<3> When  OK  is clicked, the settings are printed in text format.  If the printer is not set, the printer settings

dialog box opens.

<4> When  Cancel  is clicked, the dialog box closes.

<5> When  Properties  is clicked, the printer settings dialog box opens.

(3) While printing is in progress, the <Printing> dialog box is displayed.

Figure 3-2.  <Printing> Dialog Box

(4) About <Printing> dialog box

<1> If  Cancel  is clicked, printing can be forcibly stopped.

<2> When printing has finished, the <Printing> dialog box is automatically closed.

(5) After printing, the settings remain the same.

Figure 3-3.  [Print...] Menu
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3.1.2   Exit

[Function]

Exits from the project manager.

[Explanation]

(1) When [Exit] is selected, the project manager is closed.

(2) Because the project information is always saved, there is no confirmation dialog box asking whether the

information is to be saved.

(3) Closing Windows has the same effect as selecting [Exit].

Figure 3-4.  [Exit] Menu
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3.2   Build

3.2.1   Build and debug

[Function]

Performs batch processing, from build to debug.

[Explanation]

(1) When [Build] → [Build and Debug], or the build and debug button  is selected, build is executed and the

debugger is started.

(2) About message “Make will be executed.  Save the editing file?”

<1> When  Yes  is selected, the editor is told to save the file being processed and to terminate.  Before

termination of the editor, the message “Save a source file and close an editor.” is displayed on the status

bar, and all menus other than [Help] are dimmed and cannot be selected.  When termination of the editor is

complete, batch processing is executed.  At this time, the file being processed by the editor is saved.

<2> When  No  is selected, batch processing is executed.  At this time, the file being processed by the editor is

not saved.

<3> When  Cancel  is selected, the status before [Build and Debug] was selected is restored.

(3) Build and debugging are performed in order almost automatically.

(4) Build processing

<1> When build has been completed normally, the debugging processing is started.

<2> To stop build, select either [Build] → [Stop Build] (refer to 3.2.5 Stop Build), or select “Stop Build” on the

tool bar.

<3> If build can not be completed normally, or if [Stop Build] has been selected, batch processing is stopped at

that point.

(5) The messages output by a language processor tool while build is being executed are output to a log file.

The log file is created in the project directory.  Its file name is “<project file name>.plg”.

(6) When build has been completed normally, the debugger is started.

If the debugger is already started, the name of the file to be downloaded by the debugger is sent to the debugger

(by TipStaDbg of the TIP function). The debugger then downloads this file. However, if a user program is

currently running on the debugger, an error is notified from the debugger via TIP, so the following message is

displayed in the Project Manager.

Figure 3-5. User Program Running Message
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(7) When debugging has been completed, batch processing is also stopped.

(8) If, when the command is executed, the target has been updated, the following message is displayed.

Figure 3-6. Rebuild Message

When  Yes  is selected, debugger is started after performing rebuild.

When  No  is selected, the debugger is started without performing rebuild.

When  Cancel  is selected, return to the original status without performing rebuild or debugging.

[Caution]

If [Build] → [Edit], [Build] → [Build], or [Build] → [Debug] cannot be executed, the [Build] → [Build and Debug]

menu is dimmed.  Even if this item is selected, batch processing is not executed.

Figure 3-7.  [Build and Debug] Menu
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3.2.2   Edit

[Function]

Starts the editor.

[Explanation]

(1) When [Build] → [Edit] or the edit button  is selected, the editor selected for the project is started.  The editor

can be set by selecting the Editor tab in <Project Manager Options> (refer to 3.4.3 Project Manager Option

Settings).  By default, the standard editor (idea-L) that designed to work with the project manager is selected.

The file that is opened in the editor is the file that is selected in the tree on the project window.

[Caution]

The editor icon is displayed on the edit button.  The image on the edit button differs depending on the editor used.

The image on the edit button shown above is that of the standard editor idea-L.

(2) If the editor cannot be started, the following message is displayed.

Figure 3-8.  Message If Editor Cannot Be Started

When this message has been closed, the status before [Build] → [Edit] was selected is restored.

(3) If there is only one file in the project, that file is opened as soon as the editor has been started.

Figure 3-9.  [Edit] Menu
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3.2.3   Compile

[Function]

Executes a language program (assembler or compiler) for only one source file.

[Explanation]

(1) When [Build] → [Compile], or the compiler button  is selected, the compiler, assembler, or structured

assembler is started.

(2) The messages output by the language processor program during compilation are displayed on the build output

window.

<1> While compilation is being executed, menus other than [Build] → [Stop Build] and [Help] are dimmed and

cannot be selected.

<2> If compilation has been completed normally, the original menu display is restored.

<3> If compilation cannot be completed normally, compilation is stopped at that point.

(3) The messages output by the language processor tool during compilation are output to a log file.  The log file is

created in the project directory.  Its file name is “<project file name>.plg”.

(4) If any of the following operations are performed before compilation, the <Confirm Rebuild> message box (refer to

Figure 3-14) is displayed:

• Changing debugging mode

• Changing series name and device name on <Project Setup>

• Changing tool options

(5) The source file that is to be compiled is selected from the source file list tree in the project window.

(6) If a source file is not selected from the source file list tree in the project window, the file selected by <Build

Setup> of [Build] → [Build Option] (refer to Figure 3-22) is compiled.  If a source file is not selected from the

source file list tree in the project window and if the file selected by <Build Setup> is not a file that can be

compiled, such as a link file, the [Compile] menu is dimmed and cannot be selected.

(7) If the following operation is executed prior to compiling, the rebuild confirmation message is displayed.

• Changing the build mode

• Changing series name and device name in <Project Setup>

• Changing tool option
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(8) About <Confirm Rebuild> message box

Figure 3-10.  Confirm Rebuild Message Box

<1> When  Rebuild  is selected, rebuild is executed (refer to 3.2.7 Rebuild).

<2> When  Build  is selected, normal build (compile) is executed.

<3> When  Cancel  is selected, the status before [Build] → [Compile] was selected is restored.

[Caution]

If the execution file for compilation is not found, the [Build] → [Build] menu is dimmed, and the build button 

is also dimmed.

Figure 3-11.  [Compile] menu
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3.2.4   Build

[Function]

Executes build processing, and starts a series of language programs (compiler, structured assembler, assembler,

linker, object converter, and list converter).

[Explanation]

(1) When [Build] → [Build] or the build button  is selected, build processing is executed.

To stop build, select either [Build] →→→→ [Stop Build] (refer to 3.2.5 Stop Build), or build stop button  on the

tool bar (refer to 3.4.3 Project Manager Option Settings).

(2) Build processing automatically creates a make file and, based on this file, starts the compiler, structured

assembler, assembler, linker, object converter, and list converter.  At this time, the name of the make file is

“project file name.mak”.

<1> When a make file is automatically created, only the files that have been changed since the previous make

file was created, and in which contain a source file, are scanned.

<2> By selecting [Project] → [Make a Make File] (refer to 3.3.7 Create a Make File), creating a make file can be

specified.  In this case, the dependency relationship between all the registered source files of the project is

checked, and the make file is completely recreated.

Caution The make file created in this case is in a format which can be used with other make

utilities (such as nmake).  Some make utilities, however, use a proprietary format, so

care must be exercised when creating a load module or hex file using other make

utilities.

(3) Build executes the compiler, structured assembler, assembler, linker, object converter, and list converter in

accordance with the make file.

(4) If build could not be started, the message "Cannot build make file. Check the path and file name." is displayed.

(5) The messages output by the language processor program during build are output to the output window.

• During build, only the [Build] → [Stop Build], and [Help] menu can be selected.

• When build is completed normally, the original menu display is restored.

• To stop build, select either [Build] → [Stop Build] or the build stop button on the tool bar.

• If build is not completed normally, or if [Stop Build] is selected, build is stopped.

(6) The start commands of the tools executed for build, and the messages output by the tools are displayed on the

output window.

Each time a tool is executed, commands and messages are successively displayed on the output window.  If the

output window becomes full as a result, the window is scrolled up.  Therefore, the oldest information disappears

and the newest information is displayed on the bottom line of the window.
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When execution of the tool started by build is terminated, the termination status is displayed as follows in the

output window.

“Normal Termination” Indicates normal termination.  When the end code is 0, termination was

normal.

“Abnormal Termination.code = nnn” Indicates abnormal termination.  “nnn” is the end code.

After build, the total number of messages displayed on the output window is displayed.

Format Build Total error(s):  n   Total warning(s):  m

Remark n: Total number of fatal errors and normal errors

m: Total number of warning messages

The total number of errors and warnings is obtained from the message line with following format.

Format Total error (s): n, Total warning (s):  m

Figure 3-12.  Make Log Screen

After build has been completed, tag jump (jump to the editor indicating the corresponding location) can be

executed by selecting the error message line on the output window.  Tag jump is executed by the following

operation:

<1> Select line Click the line from which tag jump is to be executed.

<2> Jump Press the return key, or double-click on the line.
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Tag jump is executed only if the selected line is in the following format.  If the line is in any other format, tag

jump is not executed.

“source file name   line number   error message”

Figure 3-13.  Tag Jump Specification

(7) The messages output from a language processor tool during build are output to a log file.  The log file is created

in the project directory.  Its file name is “project file name.plg”.

(8) If one of the following operations was performed before build, the <Confirm Rebuild> message box is displayed.

• Changing debugging mode

• Changing series name and device name in <Project Setup>

• Changing tool options

Figure 3-14.  <Confirm Rebuild> Message Box
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(9) About <Confirm Rebuild> message box

<1> When  Rebuild  is selected, rebuild is executed (refer to 3.2.7 Rebuild).

<2> When  Build  is selected, normal build is executed.

<3> When  Cancel  is selected, the status before [Build] → [Build] was selected is restored.

(10) If, when the command is executed, the target has been updated, the following message is displayed.

Figure 3-15.  Confirm Rebuild Message When Target Was Updated

When the  Yes  button is selected, the debugger is started after performing rebuild.

When the  No  button is selected, the debugger is started without performing rebuild.

(11) If the [Build] command was executed when the debugger was started, the name of the load module file to be

downloaded by the debugger is sent (by TipStaDbg of the TIP function) to the debugger. The debugger then

downloads this file.

[Caution]

If the execution file for build is not found, the [Build] → [Build] menu is dimmed, and the build button is also

dimmed.

Figure 3-16.  [Build] Menu
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3.2.5   Stop build

[Function]

Stops the build processing under execution.

[Explanation]

When [Build] → [Stop Build] or the stop built button  is selected, the build processing under execution is

stopped.

<1> If batch processing (refer to 3.2.1 Build and debug) is being executed, it is also stopped as soon as the

build processing has been stopped.

<2> If a source is being corrected from the debugger, an error is reported to the debugger after [Build] has been

stopped.

[Caution]

• If build is not in progress, the [Build] → [Stop Build] menu is dimmed and cannot be selected.  It is displayed

normally and can be selected during build.

• [Stop Build] and the stop build button are ignored if they are selected when build has been already stopped.

• If any command (such as a C compiler or assembler command) is already under execution when [Build] →
[Stop Build] is selected, build is stopped after that command has been terminated.

• Even if [Build] → [Stop Build] or the stop build button is selected, build is not stopped until the project manager

has received a termination report from build.

Figure 3-17.  [Stop Build] Menu
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3.2.6   Debug

[Function]

Starts the debugger.

[Explanation]

(1) When [Build] → [Debug] or the debug button  is selected, the debugger is started.

(2) After the debugger has been started, the project manager specifies the name of the file to be debugged, and

transmits a debugging start message.

(3) If the debugger has already been started, the debugger window becomes the active window.

(4) If the debugger cannot be started, the message “Cannot execute.  Make sure the path or the file name.” is

displayed.

(5) If the debugger is already started, the name of the file to be downloaded by the debugger is sent to the debugger

(by TipStaDbg of the TIP function). If a user program is currently running on the debugger, an error is notified

from the debugger via TIP, and the project message displays the following message.

Figure 3-18.  User Program Running Message

(6) When a file is being downloaded to the debugger, the name of that file is displayed in the PM32 Output Window.

Figure 3-19.  Download Message

[Caution]

• If the execution file of the debugger is not found, the [Build] → [Debug] menu is dimmed, and the “debug”

button is also dimmed.  The debugger is not started even if [Debug] menu or debug button is selected.

• The icon of the debugger is displayed on the “debug” button.  The image on the debug button differs depending

on the debugger used.  The image of the debug button shown above is that of the ID78Kx (optional) debugger

for the 78K Series.
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Figure 3-20.  [Debug] Menu

3.2.7   Rebuild

[Function]

Unconditionally recreates all targets.

[Explanation]

(1) When [Build] → [Rebuild] or the rebuild button  is selected, build is started for all targets.

(2) The other operations are the same as those described in (2) to (10) in 3.2.4 Build, except that all targets are

unconditionally recreated.

(3) If the [Rebuild] command was executed when the debugger was started, the name of the load module file to be

downloaded by the debugger is sent (by TipStaDbg of the TIP function) to the debugger. The debugger then

downloads this file.

[Caution]

If the file for which build is to be executed cannot be found, the [Build] → [Rebuild] menu is dimmed, and the

Rebuild button is also dimmed.

Figure 3-21.  [Rebuild] Menu
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3.2.8   Build-related settings

[Function]

Makes settings related to build.

[Explanation]

(1) When [Build] → [Build Option] or the build setting button  on the tool bar is selected, the <Build Setup>

dialog box is displayed.  This dialog box consists of the following two tabs:

• Specified Target

• Build Setup

<1> The tabbed page can be switched by clicking the tab label.  It can be also switched by pressing the

CTRL  +  TAB  keys.  If the focus is on one of the tabs, the tabs can be switched by pressing the  ←  or

→  key.

<2> When  OK  is selected, all the items specified in the <Build Setup> dialog box become valid, and the

dialog box is closed.

<3> When  Cancel  is selected, the status before [Build Option] was selected is restored.

(2) When <Debug Target> tab is selected

A list of the files that can be a final target is displayed.

Any file can be selected from this list.  The selected file will become valid from the next build, rebuild, or compile.

Specify the final file to be created during execution of build.  During compilation, this is valid only when a

language (source) file is specified with a target specified.

Only one file can be selected at one time.

If the version of the tool DLL of the compiler or assembler is old, the name of that object file may be displayed in

the <Target> list. In this case, do not select that object file, or download to the debugger may not be performed

normally.
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Figure 3-22.  When Selecting Specified Target Tab in <Build Setup> Dialog Box

(3) When selecting <Build Setup> tab

<1> Build mode

Sets the build mode. Table 3-1 lists the two build modes.

Table 3-1.  Build Mode Types

Radio Button Function

Debug Build Executes build outputting the symbol information for debugging.

Release Build Executes build without outputting the symbol information.

When build is executed in this mode, source debugging cannot be performed.

The default mode immediately after creating a project file is the Debug Build mode.

<2> Make file creation during build

Table 3-2 shows the selectable creation modes.

Table 3-2.  Make File Creation Mode During Build

Radio Button Description

Make always A make file is automatically created when build starts (default setting).

Not make No make file is created.

When necessary A make file is created only when a project/build setting or a tool option has changed.

• When “Make always” is selected, a make file is automatically created when build starts.

• When “Not make” is selected, no make file is created.

• When “When necessary” is selected, a make file is created only when a project/build setting or a tool

option has changed.
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For the check box “Make once when project is opened” (this is checked by default),

• If it is checked, a make file is created once only for a build immediately after opening a project.

Thereafter, no make file is created.

• If it is not checked, no project file is created immediately after opening a project,

• When “Make a Make File” is executed after opening a project, no make file is created automatically when

build starts.

<3> Open log file when build failed

A log file opens upon occurrence of a build error.  This is not checked by default.

<4> Stop to build on compile error

If an error occurs during a compilation, the build will stop after the executing source file compilation has

ended.

On the other hand, when this is not checked, the build will not stop until the compilation of all source files

has ended, even if an error occurs during the compilation.

If the compilation of all source files ends normally when a target has been set after a link, the processing

shifts to the link process.  This is not checked by default.

<5> Prompt message box at build finished

A sound, in place of displaying a message box, informs you that build has ended.  This is checked by

default.

The sound depends on the WAV file specified in “Sounds” on the Control Panel.

• At normal end: The sound specified in “Warning’.

• At error end: The sound specified in “Message (warning)’.

[Caution]

When the project has not been opened and no source file has been registered to the project, the [Build]

→ [Build Option …] menu is dimmed, and the rebuild setting button is also dimmed.

Figure 3-23.  When Selecting Build Setup Tab in <Build Setup> Dialog Box
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Figure 3-24.  [Build Option] Menu

3.2.9   User-registered tool title

[Function]

Executes a tool registered by the user (custom tool).  A tool is registered by selecting [Option] → [Tools...] (refer to

3.4.2 Register Tools).

[Explanation]

(1) The menu displayed below the [Build] menu contains the titles corresponding to each tool registered in the

<Tools> dialog box.  When either a title is selected or a custom tool start button on the tool bar is selected, the

corresponding command is executed.

<1> If the tool cannot be started, “Cannot execute.  Make sure the path or the file name.” is displayed.

<2> If nothing is registered in the <Tools> dialog box, nothing is displayed in the user-registered menu position.

Nor is a button on the tool bar used for starting the custom tool displayed.

<3> The button on the tool bar for starting the custom tool may not be displayed depending on the option

settings even when a tool is registered in the <Tools> dialog box.

Figure 3-25.  Example of Custom Tool Menu
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3.3   Project

3.3.1   New

[Function]

Initializes the settings of the project and opens the settings dialog box for a new project.

[Explanation]

(1) When [Project] → [New] or the new project creation button  on the tool bar is selected, the <New Project step

1/2 (Project Information)> dialog box is displayed.  In addition, the registry settings are checked.  If the registry

settings are not found, “Not found Project manager information of Register.  Close Project Manager.” is

displayed, and the project manager is terminated (refer to [Caution]).

Figure 3-26.  [New] Menu

Figure 3-27.  <New Project step 1/2 [Project Information]> Dialog Box
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(2) To create a new project, perform the following settings in order:

<1> Project settings (refer to 3.3.6 Project Settings.)

Here, the project file name, project title, project directory, and the device to be used, are selected.

• Project File Name

Specify the name of the file to which the project information is to be saved.

• Project Directory

Specify the directory to which the project file is to be saved. Clicking the [Browse] button displays the

<Browse> dialog box for specifying the project file.

Figure 3-28.  <Browse> Dialog Box

• Title

Specify the title to be displayed in the project window. If this is omitted, the name of the project file is

displayed in the project window.

• Series Name and Device Name

Specify the device file to be used. The first series name registered to the NECDEV registry and the first

device name are displayed immediately after the <New Project step 1/2 [Project Information]> dialog box

(Figure 3-27) is opened.

•   Device Install…

When this button is selected, the device file installer is started and a new device can be registered.

However, even if a device is registered after the device file installer has been started by selecting this

button, it cannot be added in real time to the New Project step dialog box of project manager. Close the

New dialog box once.

When the  Next>  button is selected, the <New Project step 2/2 [Source Files Setup]> dialog box (Figure

3-29) is displayed. If the project file name, project directory, series name, or device name has not been

set, the  Next>  button is disabled.

When the  Cancel  button is selected, the procedure to create a new project is stopped, and the previous

status (the status in which the previously loaded project file can be used) is restored.

The  <Back  button is always disabled.
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<2> Source Files Setup

Figure 3-29.  <New Project step 2/2 [Source Files Setup]> Dialog Box

Here, the name of the source file to be registered to the project is registered.

• Source File Name

Displays the name of the source file to be registered to the project.

•   Add…

Select the source file to be added to the project. When this button is clicked, the <Add source file to the

project> dialog box (Figure 3-30) is displayed. When a source file is selected and the  Open  button is

clicked, the selected source file is added to the project. More than one source file can be specified.

Figure 3-30. <Add source file to the project> Dialog Box

•  Delete

This button is used to select a file from the Source File Name list box and delete it. More than one source

file can be selected by using the Shift key and the Control key.
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•  Delete All

Deletes all the file names displayed in the Source File Name list box from that list box. The deleted

source file names are not registered to the project. If there are no source file names in the Source File

Name list box, this button is disabled.

•  Up

Moves the selected file in the Source File Name list box one line up. The source files are registered to

the project file in the order in which they are displayed in the Source File Name list box. Build is executed

in the order in which the source files are registered.

•  Down

Moves the selected file in the Source File Name list box one line down. The source files are registered to

the project file in the order in which they are displayed in the Source File Name list box. Build is executed

in the order in which the source files are registered.

• When the  <Back  button is clicked, the <New Project step 1/2 [Project Information]> dialog box (Figure

3-27) is opened. At this time, the information of the set source file name is held.

• When the  Finish  button is clicked, the new project creation procedure is completed, and the a project

file is created according to the project information and source file.

• When the  Cancel  button is clicked, the new project creation procedure is stopped, and the previous

status (the status in which the previously loaded project file can be used) is restored.

<3> Make file creation (Refer to 3.3.7 Create a Make File).

A make file is automatically created if  Finish  is selected in [Source Files Setup].  No dialog box or

message is displayed.

[Caution]

(1) If the registry settings (NEC tool information) are not correct, the project manager will not run.  Reinstall the

project manager.

(2) If the project information has been changed, the project information is updated.

(2) When a new project file with the same name as an existing project file is created, the existing project file is

renamed in the format of “project_file_name.prj.bak”.

Example  test.prj → test.prj.bak
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3.3.2   Open

[Function]

Selects the contents of a specified file as project information.

All windows are restored to the status when the project was previously closed based on the window display status

saved to a file.

[Explanation]

(1) When [Open] or the open button  on the tool bar is selected, the <Open> dialog box is displayed.

Figure 3-31.  [Open] Menu

Figure 3-32.  <Open> Dialog Box



CHAPTER  3   FUNCTIONS

User’s Manual  U15636EJ1V0UM 51

(2) About <Open> dialog box

<1> File names are displayed in the text box and a list box.

<2> When the dialog box is open, the file type selected is “*.prj” and “*.prj” files in the project directory are

displayed in the list box.

<3> A single file or multiple files (wild cards), a directory, or a drive can be specified in “File name”.

<4> If only one file name is specified and  Open  is clicked, that file is selected, and this dialog box is closed.

<5> If multiple files are specified and  Open  is clicked, a list of the files is displayed in the file name list box.

<6> If a directory is specified in “File name” and  Open  is clicked, the directory changes and a list is displayed in

the file name list box.

<7> When a drive is set for “File name” and then  Open  is selected, the drive and directory change and a list is

displayed in the file name list box.

<8> If the file name list box is clicked, a file can be selected in the list box, and the selected file name is shown

in the text box.

<9> “Project (*.prj)” is available as a file type.  When this is selected, “*.prj” is displayed in the text box, and the

list display shows project files.

<10>The “Look in” drop-down list box displays the file hierarchy.  When a directory is selected, files are

displayed in accordance with “Save as Type” in the file list box.

<11>If a drive name is specified from the list box (editing not possible) and changed, this is also reflected to the

file name and directory.

<12>Since the title is in the display area, it cannot be edited. The title is empty when no list box contents are

selected.

<13>When  Cancel  is selected, the status before [Open] was selected is restored.

(3) The contents of the file selected in the <Open> dialog box are used as project information.  If an error occurs

while the selected file is being read, an error message is displayed.  After the error message has been closed,

the data that caused the error is changed to the default value, and the processing continues.  If an item for which

no default value exists causes an error, however, the project manager is initialized to the status immediately after

starting.

(4) If a project file is dragged to the project window, the contents of that file are used as project information.

(5) If a project is moved, it can be opened since the Project Manager recognizes it automatically.

<1> If the project was moved, the file path in the project file is changed so as to reflect the new project file

location. The project file prior to the change is left in the format "project_file_name.prj.bak".

<2> The following message is displayed if path change is failed.

Figure 3-33.  Message When Path Change Failed

This message displays the name of the file for which the path change failed. If the path change failed,

writing is performed to the newly created project file with the previous file location unchanged.

The configuration for which path change failed is as follows.
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<Previous project configuration>

c:\master\prj\master.prj Project file location

c:\master\main\c Source file (directory just above project file)

<Project configuration after copy>

c:\master\prj\master.prj Project file location

c:\master\main\c Source file ← Where conversion error occurred

An error occurs because the source file path cannot be changed since the project file is located in the

topmost directory. When an error occurs, the source file location (c:\master\main\c) remains

unchanged.

<3> The following errors may be displayed when changing a project file name.

• In case of a write error when changing the name of a project file

tmp file name

“F319: Cannot create temporary file.”

• In case of bak file could not be deleted

bak file name

“F114: Cannot delete file.”

• In case the prj file name could not be changed to the bak file name

bak file name

“F114: Cannot create file.”

• In case the tmp file name could not be changed to the prj file name

prj file name

“F114: Cannot create file.”

• In case no source file could be registered when the changed prj file was opened

First source file name that could not be registered

“F128: A number of source files cannot be set.”

<4> The following message is displayed when a project file prepared with another NEC tool such as a debugger

is specified.

Figure 3-34.  Message When Project File Created with Another Tool Is Loaded

When the  OK  button in this message box is clicked, the <New Project step 1/2 [Project Information]> dialog

box (Figure 3-27) is opened. However, this dialog box differs from the regular <New Project step 1/2

[Project Information]> dialog box as follows.
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Table 3-3.  Difference with <New Project step 1/2 [Project Information]> Dialog Box

Contents Before Change Contents After Change

Title of dialog box New Project step 1/2 [Project

Information]

Update project

<Project File Name>

edit box

• Specified project file name

• Edit box can no longer be selected.

<Project Folder>

edit box

• Path of specified project file

• Edit box can no longer be selected.

When the project information has been set, the project manager updates it to a usable project file.

3.3.3   Save

[Function]

Saves the current project information by overwriting.

[Explanation]

When [Save] or the save button  on the tool bar is selected, the current project information is saved to the file

with the current name.

Figure 3-35.  [Save] Menu

[Caution]

If no project file name is set, the menu item is dimmed, and [Save] cannot be used.
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3.3.4   Save as

[Function]

Saves the current project information and the display status of windows to a specified file.

[Explanation]

(1) When [Save As] is selected, the <Save As> dialog box is opened.

Figure 3-36.  [Save As] Menu

Figure 3-37.  <Save As> Dialog Box

(2) About <Save As> dialog box

<1> File names are displayed in the text box and a list box that displays a list of file names.

<2> The file name saved for the first time is treated as a project file name, and a list of the “*.prj” files is

displayed in the list box.

<3> A single file, multiple files (wild card), a directory, or drive can be specified in “File name”.

<4> If only one file name is specified and  Save  is clicked, that file is selected and this dialog box is closed.
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<5> If multiple file names are specified and  Save  is selected, these files are selected and this dialog box

closes.

<6> If a directory is specified as the file name and  Save  is clicked, a list of files is displayed in the file name list

box, and the directory is shown in “Save in”.

<7> If a drive is specified in “File name” and  Save  is clicked, a list is displayed in the file name list box, and the

drive is shown in “Save in”.

<8> If the file name list box is clicked, a file is selected and displayed in the list box, and the file name is

reflected in the text box.

<9> “Project (*.prj)” is available as a file type.  When this is selected, “*.prj” is displayed in the text box, and the

10

<10>The “Save in” drop-down list box displays the file hierarchy.  When a directory is selected, files are

displayed in accordance with “Save as Type” in the file list box.

<11>The drive name is specified in the list box (editing is not possible), and when it was changed, the change is

also reflected to the file name and directory.

<12>If  Cancel  is clicked, the status before [Save As] was selected is restored.

(3) The current project information is saved to the file selected in the <Save As> dialog box.

If an error occurs while the file is being saved, a message is displayed.  After the message has disappeared, the

processing continues, if it can, without saving only the data that caused the error.  If the processing cannot be

continued, processing is stopped as soon as the error occurs.  At this time, the data from which saving was

started to the data at which the processing was stopped is saved.

(4) For details on saving the windows status and the windows that can be restored, refer to Table 3-4 Saving

Window Status and Windows That Can Be Restored.

Table 3-4.  Saving Window Status and Windows That Can Be Restored

Window to Be Saved or Restored Saved/Restored Elements

Project Manager, normal window Position, size, display

[Caution]

• If the extension of a file name is omitted, “*.prj” is assumed.  If the extension is other than “*.prj”, the following

error message is also displayed.  After the error message has been closed, the status before [Save As (A)] was

selected is restored.

Figure 3-38.  Error Message If File Extension Is Not .prj
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3.3.5   Close

[Function]

Closes the project.

[Explanation]

When [Close] is selected, the current project file is closed and the untitled state is entered.

In this case, all the settings are the same as those in the untitled state.

Figure 3-39.  [Close] menu
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3.3.6   Project settings

[Function]

Sets the information for a project.

[Explanation]

When [Project Setup…] or the project setup button  on the tool bar is selected, the <Project Setup> dialog

box is displayed.

Figure 3-40.  [Project Setup…] Menu

Figure 3-41.  When Project Information Tab Is Selected in <Project Setup> Dialog Box

The <Project Setup> dialog box consists of the following three tabs:

• Project information

• Source file

• Memo
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(1) When the project information tab is selected

<1> A project file name can be input from the keyboard or can be set by displaying a file selection dialog box

using  Browse .  Once a file name has been selected, it is displayed when [Project Setup…] is selected

again next time.

<2> A title related to the project can be input from the keyboard.  The title can be viewed when selecting [Open]

or [Save As].

<3> A project directory can be input from the keyboard or a file name can be set by displaying the project

directory setting dialog box by using  Browse .  The project file and various files that constitute a project are

registered in the selected directory.  If the specified directory does not exist, a confirmation dialog box asks

whether the directory is to be created, and the directory is created.

If [Project Setup…] is selected with a project already open, the selected project directory is displayed.

<4> The series name of the target device can be selected from the drop-down list.  The names of the series that

have been installed are displayed in the drop-down list.  While the debugger or simulator is being started,

this drop-down list is disabled.

<5> A target device name can be selected from the drop-down list.  The names of the devices that have been

installed are displayed in the drop-down list.  While the debugger or simulator is being started, this drop-

down list is disabled.

<6> Up to 255 characters can be input in the project file name text box (12 characters or less is recommended),

246 characters as a project directory name (128 characters or less is recommended), and 64 characters as

a title.  If a name exceeding the recommended range is specified, some tools (MS-DOSTM applications) may

not be able to be used.

<7> When a project file name, series name, and device name are selected and then  OK  is clicked, the file

name is set.

<8> The extension of a project file name must be “.prj”.  If no extension is specified, “.prj” is appended.  If any

other extension is input, the following message is displayed:

Figure 3-42.  Message If Extension Is Not .prj

<9> If the specified project file name already exists, the following message is displayed:

Figure 3-43.  Message If Specified File Already Exists
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<10>The project file name is displayed on the title bar of the Project Manager.

(a) Registering new device file

When the [Device Install...] button is clicked, the device file installer is started and it is possible to

register new devices. However, even if a device is registered after the device file installer has been

started, it cannot be registered in real time to the New Project step dialog box of project manager.

The <New> dialog box must be closed once. Refer to CHAPTER 6  DEVICE FILE INSTALLER.

[Caution]

• The title of the window is “Project Manager - XXXXX - YYY (ZZZZZZZ)”.  “XXXXX” indicates the project file

name, YYY indicates the series name, and ZZZZZZZ indicates the device name.  If no project file name is

specified, “Untitled” is displayed.

• A device file is a binary file in which information on the device such as the special function registers (SFR) of

the device is written, and is available for each device.  A device file is necessary for creating a load module or

executing debugging.  For details of how to install a device file, refer to CHAPTER 6 DEVICE FILE

INSTALLER (DFINST).

(2) When selecting source file tab

Figure 3-44.  When Selecting Source File Tab in <Project Setup> Dialog Box

<1> If a source file has been already specified, the source file information defined in that file is displayed in

“Source File Name” in a specified sequence.

<2> Two or more source files can be selected from those displayed in “Source File Name” by selecting source

files while holding down the shift key or control key.  The selected files can be manipulated by using the

Delete  ,  Up  , and  Down  buttons.

<3> To add a source file to the project, specify the position at which the file is to be added, and click the  Add...

button.  When this button is clicked, the <Add source file to the project> dialog box (refer to (a) below) is

displayed.  Specify the source file to be added to the project in this dialog box.



CHAPTER  3   FUNCTIONS

User’s Manual  U15636EJ1V0UM60

<4> The source file is added immediately after the source file selected in “Source File Name”.  If no source file is

selected, it is added to the end.

<5> The source file select point is saved in the following cases.

• During compilation

• During make file creation

• During compile option setting (excluding when an include file is selected)

<6> Another method to add a source file to the project is to drag a source file to the project window (refer to

1.4.1  Starting) from Explorer.  The source file may be dropped anywhere in the window.

The file will be added at the position explained above.

<7> One method to delete a source file from the project is to click the  Delete  button after selecting a file from

“Source File Name”. If there are no source files, or if no source file is selected, the  Delete  button is

dimmed.

Another method is to click the file to be deleted from the source files displayed in the project window, and

press the  DEL  key.

<8> A file name can be selected from “Source File Name” and the selected file name can be moved by using the

Up  and  Down  buttons.  Two or more source files can be selected in “Source file name” and moved all at

once.

<9> If no source file is selected, the  Up  and  Down  buttons are dimmed.  If the selected source file cannot be

moved up, the  Up  button is dimmed.  If the file cannot be moved down, the  Down  button is dimmed.

<10>To delete all the source files registered to the project, click  Delete All  .  If there are no source files,

 Delete All  is dimmed.

<11>If  OK  is clicked, the source file is assigned to the project with the contents and in the sequence displayed

in “Source File Name”.  After the file has been assigned, the <Project Setup> dialog box is closed.

<12>If a source file is added after the debugger has been started, it is added to the debugger’s source path

unless the path of the added source file is set as the debugger’s source path. However, if the debugger

displays the <Debugger Option> dialog box, do not add a source path.

<13>If  Cancel  is clicked, the operations performed in the <Project Setup> dialog box become invalid, and the

dialog box is terminated.

<14>Registering a file with an extension other than source file extension causes the message “F144: The file

extension is illegal” to be displayed.  If “Display dependencies of source files” is checked, the files with

dependency relationships are displayed.  If the check is removed, files other than source files are not

displayed.

<15>If tool options are set or an individual source file, an asterisk “*” is displayed to the left of the source file

name.
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(a) About <Add source file to the project> dialog box

Figure 3-45.  <Add source file to the project> Dialog Box

<1> File names are displayed in the text box and a list box.

<2> The file names that are initially displayed differ depending on the series selected for the project

(for example, “.s”, “.asm”, or “.c” is displayed with the 78K Series).  The list box displays a list of

project directories.

<3> Wild card characters, a directory, drive, or a file name, can be specified in “File name”

<4> If wild card characters are specified for “File name” and  Open  is clicked, a list is displayed in the

file name list box.

<5> If a directory is specified in “File name” and  Open  is clicked, a list is displayed in the file name list

box, and the directory is shown in “Look in”.

<6> If a drive is specified in “File name” and  Open  is clicked, a list is displayed in the file name list

box, and the drive is shown in “Look in”.

<7> If the file name list box is clicked, a file is selected and displayed in the list box, and the file name

is shown in the text box.

<8> The “Look in” drop-down list box displays the file hierarchy.  When a directory is selected, files are

displayed in accordance with “Save as Type” in the file list box.

<9> If an error occurs when the specified file has been read, an error message is displayed.  After the

error message has disappeared, the processing continues, ignoring the data that caused the error.

<10>Two or more source files can be selected from those displayed in the list box by selecting source

files while holding down the shift or control key.  The selected source files are displayed in the file

name text box.

<11>If a file not registered is specified in the file name text box when  Open  is clicked, the <Create a

Source File> dialog box, which is used to select whether a file is to be created, is displayed.
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(b) About <Create a Source File> dialog box

Figure 3-46.  <Create a Source File> Dialog Box

<1> The input file name is displayed in the message in the dialog box.

<2> If  Yes  is clicked, the specified file is created with nothing in it, and is registered in the source file

list in the source file tab in the <Project Setup> dialog box.

<3> If  No  is clicked, the specified file name is invalid.

[Caution]

• Build executes assembly and compilation in the sequence shown in the source list and in accordance with the

program type.

The path of the project directory is used as the path name of the source files when build is executed (the path

of the project directory is used as the current directory for processing).

• The sequence of linking is dependent on the tool DLL for the linker of the series used and the linker.

(3) When memo tab is selected

Figure 3-47.  When Memo Tab Is Selected in <Project Setup> Dialog Box
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<1> The contents of the memos specified in “Memo” and their dates of creation are displayed in the “Memo” list

box.

<2> If  Add…  is clicked, the <Memo Addition> dialog box is displayed and characters can be input.

<3> Up to 237 memos can be specified in the “Memo” list box.  When 237 memos have been specified, the

Add…   button is dimmed, and no more memos can be added.

<4> If  Delete  is clicked after a date in the “Memo” list box has been selected, that date can be deleted from the

list box.  If no memos are specified or if “Date” is not selected, the  Delete  button is dimmed and the date

cannot be deleted.

<5> To delete all the memos in the “Memo” list box, click  Delele All .  This button is dimmed when no memos

are specified.

<6> If  OK  is clicked, the set memo date information becomes valid, and the <Project Setup> dialog box is

closed.

<7> If  Cancel  is selected, the settings in the <Project Setup> dialog box become invalid, and the dialog box is

closed.

Next, the <Memo Addition> dialog box is explained.

Figure 3-48.  <Memo Addition> Dialog Box

<1> Characters of up to 256 bytes can be input in the “Memo” text box.

<2> If  OK  is clicked, the set memo information becomes valid, and the <Project Setup> dialog box is displayed

again.

<3> If  Cancel  is clicked, the set memo information becomes invalid, and the <Project Setup> dialog box is

displayed again.

[Cautions]

The dates of memory data used before Project Manager Ver.3.12 are in the “YY/MM/DD” format. The date format

used in Project Manager Ver. 3.15 is “YYYY/MM/DD”.

Display of the lower two digits of the Christian Era year has been changed to 4-digit display. If date data consisting

of 2 digits is loaded, “19” or “20” is automatically prefixed so that “19xx” or “20xx” is displayed.

YY = “00” to “79” becomes “2000” to “2079”.

YY = “80” to “99” becomes “1980” to “1999”.
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3.3.7   Create a make file

[Function]

Creates a make file.

[Explanation]

Figure 3-49.  [Make a Make File] Menu

A make file is automatically created when build is executed.  When [Make a Make File] is selected, however, a

make file is always created or updated, regardless of whether the settings of the existing make file have been

changed.

Usually, users do not have to be aware of the make file.

<1> If [Make a Make File] or the create make file button  on the tool bar is selected, a new make file is

created based on the source file and the settings of various tool options set for the project.  While a make

file is being created, a hourglass is displayed at the cursor position.  The message “Making a make file.” is

displayed on the status bar.  When the make file has been created, the arrow cursor is displayed, and

“Completed to make a make file.” is displayed on the status bar.

<2> If [Make a Make File] is selected, the existing source files are always checked, the dependency relationship

information of the make file is updated, and a make file is created.

<3> The files on which a source file depends are recursively scanned by checking dependent files with other

dependent files.

<4> The make file is created with the name “project file name.mak”.  If a make file already exists, it is

overwritten.

<5> Parameters for a language processor program may be created as a result of creating a make file.  The

make file to be created differs depending on the series.

<6> For details of the make file, refer to 3.2 Build.

[Caution]

Unless the information necessary for creating a make file (such as project file name, series name, device file

name, and source file name) is provided, the menu item is dimmed.
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3.3.8   Project name

[Function]

Starts a project.

[Explanation]

Figure 3-50.  [Project Name] Menu

(1) The nine most recent project file names of the projects that have been opened so far are listed under [Project].  A

project can be opened by selecting a file name.

(2) If a project has been opened by selecting [Project] → [Open], or if a [Project Name] has been opened, the

opened project is displayed on the first line of the list of project file names.

If a project that is not registered in the menu is opened, the ninth project in the list is deleted, and the projects

from the first line and downward are moved down.
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3.4   Options

3.4.1   Tool option settings

[Function]

Sets the options of the tools (structured assembler, assembler, linker, object converter, and list converter) that run

on the project manager.

[Explanation]

(1) If [Tool Options] or the tool option settings button on the tool bar (refer to 2.2 Buttons) is selected, the project

manager calls the option setting function of the DLL, and displays the option setting dialog box.

Figure 3-51.  Option Setup Dialog Box (of Assembler)

(2) [Tool Options] are displayed at the top of the [Option] menu, and as many menu items as the number of tools

having an option setting function are created.  The number of menu items created differs depending on the

series used.
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Figure 3-52.  [Tool Options] Menu

(3) Options for tools that process source files can be set for each source file .

The overall option settings are applied to source files for which options are not set.

If [Tool Options] is selected with a source file selected in the project window, options are set for the selected

source file.  In this case, the selected source file icon on the project window is colored.

To set a common option, clear selection of a source file in the project window and select [Tool Options].  In this

case, the selected source file icon is not colored.

Figure 3-53.  Option Setting for Each Source File

(4) Options set for each source file can be deleted in the source file option setting dialog box.

(5) For details on how to set the options for each tool, refer to RA78Kx Assembler Package Operation User’s

Manual.
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3.4.2   Register tools

[Function]

Registers any program in the [Build] menu of the project manager as a menu item.

[Explanation]

(1) If [Tools...] or the register tool button  on the tool bar is selected, the <Register Tool> dialog box is

displayed.

Figure 3-54.  [Tools…] Menu

Figure 3-55.  <Register Tool> Dialog Box

(2) About <Register Tool> dialog box

<1> The titles of set tools are displayed in the “Menu Title List”.  The titles are also used as a menu items.

<2> Up to 10 titles can be displayed in the “Menu Title List”.  When 10 titles have been set, the  Add...  button is

dimmed, and no more titles can be added.

<3> To set a tool, click the  Add...  or  Edit...  button to display the <Select Tool> dialog box.  Display the

<Browse> dialog box (refer to (3)) by using the  Browse  button in the <Select Tool> dialog box.  A tool can

be set in this dialog box or in the text box.
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Figure 3-56.  <Select Tool> Dialog Box

<4> A file name can be input in “Tool file name”.

<5> Specify the arguments of the tool in “Parameter”.  Or, select a tool from the “Menu Title list”, input the

arguments of the tool, and click the  OK  button.

<6> Specify the current folder when the tool is started, in “Tool folder”.

<7> Specify the title to be displayed in [Build] → [Menu Title List], in “Menu title”.

<8> Specify the title of help in “Tool tip title”.

<9> Specify the title to be displayed on the status bar in “Status bar title”.

<10>If the specified title (title to be displayed on the menu) has been already registered, the following message

is displayed.  After the message has disappeared, the status before  Add...  was clicked is restored.

Figure 3-57.  Message If File Name Has Already Been Registered

<11>If a file name has been input in “Tool file name” or a title has been input in “Menu title”, the file name or title

can be added to the last position on the list by using  Add... .

<12>Up to 128 characters can be input as a tool file name.

<13>Up to 32 characters can be input as a title.

<14>If a tool file name is not input, the <Register Tool> dialog box is displayed.

<15>If a title is not input, the tool file name, excluding the path and extension, is used as the title name.
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<16>If a file name does not exist, the message “Not found the path or the file.  Make sure the path or the file

name.” is displayed.  After this message has been displayed, the status before  Add...  was clicked is

restored.

<17>If the specified file name is illegal, the message “Illegal path or file name.  Enter a right path or file name.” is

displayed.  After this message has been displayed, the status before  Add...  was clicked is restored.

<18>The title and tool file name can be changed after specifying a title name in “Menu Title List”, and that title

name or tool file name can be changed by using  Edit...  .

<19>If the specified title has been already registered, the message “The title has already existed.” is displayed.

After this message has been displayed, the status before  Edit...  was clicked is restored.

<20>If no title is specified in “Menu Title List”, the  Edit...  button is dimmed, and no change can be made.

<21>If  Edit...  is selected without changing the title or tool file name, the <Select Tool> dialog box is displayed.

If a file is selected in this dialog box and  OK  is clicked, the tool selected in the title list is changed.

<22>A file name can be deleted by specifying a title in “Menu Title List” and using  Delete .  If a title is not

specified in “Menu Title List”, the  Delete  button is dimmed, and the file name cannot be deleted.

<23>After specifying a title in “Menu Title List”, the title can be moved using  Up  or  Down  .  If the title cannot be

moved up or down from the current position, the  Up  and  Down  buttons are dimmed.

<24>If  OK  is clicked, all the title and tool file names displayed in “Menu Title List” are set, and the dialog box is

closed.  If  Cancel  is clicked, the status before [Tools...] is displayed is restored.

<25>To delete all the registered tools, click  Delete All  .  This button is dimmed when no tools are registered.

<26>When a tool has been registered, a custom tool start button is created on the tool bar.

[Caution]

• Two or more tools that are displayed with the same characters in the menu cannot be registered.  Uppercase

and lowercase characters displayed in the menu are not distinguished.

• If no title has been input, “Tool file name” excluding the path and extension is assumed as the title.

• The  OK  button is dimmed if nothing is specified in “Tool file name” and “Tool folder”.  The other information

can be registered even if it is blank.

(3) <Browse> dialog box

Figure 3-58.  <Browse> Dialog Box (with Executable Files)

<1> File names are displayed in the text box and list box.
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<2> The initial file types are “*.exe;*.com;*.bat” and a list of the files in the tool directory is displayed in the list

box.

<3> Single or multiple files (wild cards), a directory, or a drive can be specified in “File name”.

<4> If one file name is specified in “File name” and  Open  is clicked, that file is selected, and this dialog box is

closed.  The title of the selected file is the file name excluding the path and extension.

<5> If two or more file names are specified for “File name” and  Open  is clicked, a list of file names is displayed

in the file name list box.

<6> If the file name list box is clicked, a file name is selected and displayed in the list box, and the selected file

name is shown in the text box.

<7> “Look in” drop-down list box displays the file hierarchy.  When a directory is selected, files are displayed in

accordance with “Save as Type” in the tile list box.

<8> If  Cancel  is clicked, the dialog box is closed.

[Example]

In an application using a real-time OS (RX78Kx), some files must be created using the MS-DOS application

“configurator (cf78kx)”.  Creating these files can be simplified by registering the configurator as a tool.
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3.4.3   Project manager option settings

Caution The option settings of the project manager become valid when a new project is opened.

[Function]

Sets the options of the project manager.

This menu can be selected whether a project is started or not.

[Explanation]

(1) If [Option] → [Project Manager Options...] or the project manager option setting button  on the tool bar is

selected, the <Project Manager Option> dialog box is displayed.

Figure 3-59.  [Project Manager Options...] Menu

(2) The options of the project manager specify the following items:

• Selection of an editor

• Whether the status bar is displayed

• Whether the project window is displayed

• Whether the standard tool bar is displayed

• Whether the tool bar for starting custom tools is displayed

• Whether the previous project file is opened at start-up

• Setting for temporary file creation directory

(3) The <Project Manager Option> dialog box consists of the following two tabs:

• PM information

• Editor

The  OK  and  Cancel  buttons can be used in both the dialog boxes.
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(4) When PM information tab is selected

Figure 3-60.  When  PM Option Tab Is Selected in <Project Manager Option> Dialog Box

<1> If “Display a Status bar” is checked, the status bar is displayed in the window of the project manager.  If it is

not checked, the status bar is not displayed.

<2> If “Display a Project Window” is checked, the project window is displayed in the window of the project

manager.  If it is not checked, the window is not displayed.

<3> If “Display a Standard Tool bar” is checked, the standard tool bar is displayed.  If it is not checked, the tool

bar is not displayed.

<4> If “Display a Custom Tool bar” is checked, the tool bar for starting the registered custom tools is displayed.

If it is not checked, the tool bar for starting the custom tools is not displayed.

<5> If “Open last project at starting” is checked, the project that had opened at the end of the last PM operation

can be opened again automatically.  If it is not checked, the PM starts in the untitled state.

<6> Specify a work directory used for each tool in “Temporary File directory” text box.  Type the work directory

in the text box, or open the <Browse> dialog box by pressing the  Browse  button and display the directory

to be selected.
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Figure 3-61.  <Browse> Dialog Box (When Browsing Directories)

<7> If  OK  is clicked, the set value is checked.  If the value is correct, the setting becomes valid, and the

<Project Manager Option> dialog box is closed.  If an error is found as a result of checking, an error

message is displayed.  Correct the error and click  OK  again.

<8> If  Cancel  is clicked, the operation performed in <Project Manager Option> becomes invalid, and the dialog

box is closed.

<9> If  Help  is clicked, the help of the <Project Manager Option> dialog box is displayed.

[Caution]

If the standard editor is already running, the editor cannot be changed.  Changes in the editor settings become

valid when the editor is started the next and subsequent times.

(5) When editor tab is selected

Figure 3-62.  When Editor Tab Is Selected in <Project Manager Option> Dialog Box
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<1> Set an editor that is to be used as the editor of the project manager.  Table 3-5 lists the editors that can be

selected.  The selected editor is started when the [Build] → [Edit] menu item or editor start button is

selected.

Table 3-5.  Selectable Editors

Radio Button Editor

“Standard Editor” Editor having function to interface with project manager (default)

“Combine with Standard Editor” Mode in which standard editor is integrated

“External Editor” Editors other than above

<2> If “Standard Editor” is selected, an editor (idea-L) that has a function to interface with the project manager is

selected.  In this case, an executable file name must be input in the “File name of Standard Editor” field.

When the  Browse...  button is clicked, a dialog box in which an executable file name can be selected is

displayed.

Figure 3-63.  <Browse> Dialog Box (with Executable Files)

<3> If “Combine with Standard Editor” is selected, the editor (idea-L) that has a function to interface with the

project manager is integrated.  In this case, the project manager becomes inactive.

If “Combine with Standard Editor” is cleared, the editor remains integrated until the project manager is

terminated.

When the project manager is restarted, the editor is no longer integrated.

If the standard editor in the non-integrated mode is executed at this time, “Combine with Standard Editor”

and check box in <Project Manager Option> are dimmed.

<4> If “External Editor” is selected, a commercially available editor can be selected.  In this case, an executable

file name must be input in the “File name of Standard Editor” field.  When the  Browse...  button is clicked, a

dialog box in which an executable file can be selected is displayed.
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<5> The option button to select an editor offers two options.  If the standard editor is selected, “File Name of

Standard Editor” and the  Browse...  button become valid, and “File Name of Standard Editor” for an

external editor, the  Browse...  button, and “Format of Tag jump” are dimmed.

If an external editor is selected, “File Name of Standard Editor”, the  Browse  button, and “Format of Tag

jump” become valid, and “File Name of Standard Editor” and the  Browse  button of the external standard

editor are dimmed.

<6> The  OK  ,  Cancel  , and  Help   button can be used in the same manner as when the PM information tab is

selected.

(6) About dialog box for browsing directories

<1> If  OK  is selected, the set values of <Project Manager Option> become valid.

<2> If  Cancel  is selected, the set values of the dialog box become invalid, and <Project Manager Option> is

displayed again.

<3> If  Network...  is selected, network drives can be browsed.
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3.4.4   Device file installer (DFINST)

[Function]

Starts the device file installer (DFINST).

[Explanation]

(1) When [Device File Installer] or the Device File Installer button  is selected, the device file installer starts.

(2) The [Device File Installer] menu executes DFINST.EXE in the NECTools folder. The following message is

displayed if execution fails.

Figure 3-64.  Message When DEFINST.EXE Execution Fails

(3) The [Device File Installer] menu is always enabled.
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3.5   Help

3.5.1   PM help topics

[Function]

Displays the <Help Topics:  PM HELP> dialog box of help.

[Explanation]

If [PM Help Topics...] or the help button  on the tool bar is selected, the help window is opened, and the <Help

Topics:  PM HELP> dialog box is displayed.

Figure 3-65.  <Help Topics:  PM HELP> Dialog Box

Figure 3-66.  [PM Help Topics...] Menu
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3.5.2   PM version information

[Function]

Displays the version of the project manager used.

When a project file is open, the versions of the NEC tools and device file corresponding to the project are

displayed.

[Explanation]

(1) If [About PM...] is selected, the <About Project Manager> dialog box is opened.

Figure 3-67.  [About PM…] Menu

(2) If  OK  is clicked in the <About Project Manager> dialog box, the dialog box is closed.

Figure 3-68.  <About Project Manager> Dialog Box
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3.6 Project Window Function

[Function]

The Project Manager has the project window display function.  The project window provides the functions to

display the current project information and to change settings.

[Explanation]

(1) The project window consists of the following two tabs:

• File

• Memo

(2) The two pages can be switched by clicking the tab label.  The File tab is selected by default.

(3) When the File tab is selected

<1> A source file list (tree structure) is displayed.

<2> The source file list can be displayed or hidden by clicking "Header Files" in the tree structure.

<3> When a source file is selected and then the  DEL  key is clicked, the selected source file is deleted from the

project file.

<4> When a project file name is dragged and dropped to a project file, the currently open project file is closed

and the dragged-and-dropped project file is read.

<5> When the right mouse button (keyboard application key) is clicked while the tree file list display is active, the

following menu is displayed.

Figure 3-69.  Right Mouse Button Menu

<6> When [Add Source File…] is selected in the right mouse button menu, the <Add Source File to the project>

dialog is displayed.  In this dialog, select the source file to be added.  The selected source file will be added

to the end of the source file folder.

The following table shows the conditions under which the menu becomes valid or invalid.
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Table 3-6.  Conditions Under Which [Add Source File…] Menu Becomes Valid or Invalid

Condition Menu Status

The project file is not open Invalid

When the title is selected Valid

When the "Source Files" folder is selected Valid

When a source file name is selected Valid

When the "Header Files" folder is selected Valid

The project file is open

When a header file name is selected Valid

<7> When [Delete Source File] is selected in the right mouse button menu, the selected source file is deleted.

The following table shows the conditions under which the menu becomes valid or invalid.

Table 3-7.  Conditions Under Which [Delete Source File] Menu Becomes Valid or Invalid

Condition Menu Status

The project file is not open Invalid

When the title is selected Invalid

When the "Source Files" folder is selected Invalid

When a source file name is selected Valid

When the "Header Files" folder is selected Invalid

The project file is open

When a header file name is selected Invalid

<8> When [Compile] is selected in the right mouse button menu, the selected source file is compiled.

The following table shows the conditions under which the menu becomes valid or invalid.

Table 3-8.  Conditions Under Which [Compile Menu Becomes Valid or Invalid

Condition Menu Status

The project file is not open Invalid

When the title is selected Invalid

When the "Source Files" folder is selected Invalid

When a source file name is selected Valid

When the "Header Files" folder is selected Invalid

The project file is open

When a header file name is selected Invalid

<9> When [Build] is selected in the right mouse button menu, build is executed.
The following table shows the conditions under which the menu becomes valid or invalid.
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Table 3-9.  Conditions Under Which [Build] Menu Becomes Valid or Invalid

Condition Menu Status

The project file is not open Invalid

When the title is selected Valid

When the "Source Files" folder is selected Valid

When a source file name is selected Valid

When the "Header Files" folder is selected Valid

The project file is open

When a header file name is selected Valid

<10>When [Edit] is selected in the right mouse button menu, the editor is started.  Selecting this menu while a

source file name is selected opens that selected source file.

The following table shows the conditions under which the menu becomes valid or invalid.

Table 3-10.  Conditions Under Which [Edit] Menu Becomes Valid or Invalid

Condition Menu Status

The project file is not open Valid

When the title is selected Valid

When the "Source Files" folder is selected Valid

When a source file name is selected Valid

When the "Header Files" folder is selected Valid

The project file is open

When a header file name is selected Valid

<11>When [Compiler Options…] is selected in the right mouse button menu, a dialog is displayed for setting the

compiler options.  Selecting this menu when a source file name with the ".c" extension is selected allows

the compiler options to be set individually for that selected source file.

The following table shows the conditions under which the menu becomes valid or invalid.

Table 3-11.  Conditions Under Which [Compiler Options…] Menu Becomes Valid or Invalid

Condition Menu Status

The project file is not open Invalid

When the title is selected Valid (overall option setting)

When the "Source Files" folder is selected Valid (overall option setting)

When a source file name with the ".c" extension

is selected

Valid (individual option setting)

When an assembler source file name is

selected

Invalid

When the "Header Files" folder is selected Invalid

The project file is open

When a header file name is selected Invalid
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<12>When [Assembler Options…] is selected in the right mouse button menu, a dialog is displayed for setting

the assembler options.  Selecting this menu when a source file name with the ".asm" extension is selected

allows the assembler options to be set individually for that selected source file.

The following table shows the conditions under which the menu becomes valid or invalid.

Table 3-12.  Conditions Under Which [Assembler Options…] Menu Becomes Valid or Invalid

Condition Menu Status

The project file is not open Invalid

When the title is selected Valid (overall option setting)

When the "Source Files" folder is selected Valid (overall option setting)

When a source file name with the ".c" extension

is selected

Invalid

When an assembler source file name is

selected

Valid (individual option setting)

When the "Header Files" folder is selected Invalid

The project file is open

When a header file name is selected Invalid

Figure 3-70.  Project Window (When File Tab Is Selected)

(4) When the Memo tab is selected

The memo information list is displayed.  The information displayed by this tab is that of the memo set by

selecting [Project] → [Project Setup…].
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Figure 3-71.  Project Window (When Memo Tab Is Selected)
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CHAPTER  4   EXAMPLE  OF  EXECUTING  PROJECT  MANAGER

This chapter explains the execution sequence of the project manager, giving examples.

4.1   Environment

It is assumed that the project manager and assembler package are installed in directory b:\nectools32\bin, and

that the sample program is in b:\work.

It is also assumed that Windows has been started.

4.2   Sample Program

The sample program shown in this example is for the RA78Kx.  Note that the sample program is not supplied with

the package.

4.3   Execution Sequence of Project Manager

This section introduces the execution sequence of the project manager.  In the following example, the target

device is µPD780058.

(1) Starting project manager

Double-click the  icon to start the project manager.

The following window will be displayed.

Project window Output window

Menu Buttons
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(2) Open the <Project Setup> dialog box by selecting [Project] → [Project Setup].  Select the project information tab,

and input a title as follows:

Title: SAMPLE

Select the target device and series from the drop-down list.
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(3) Next, select the source file tab and input a source file.

(4) The project setup has been completed.  Next, select [Option] → [Assembler Options] to set the options of the

assembler.
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(5) To set an individual option, select the file tab in the project window, and select a source in “Source Files” so that

the selected file is highlighted.

(6) Select [Option] → [Linker Options] and set each linker option.
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(7) Select build by selecting the build button  or the [Build] → [Build] menu item.  A make log screen will be

displayed.
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(8) Because an error has been found, tag jump is performed.

Move the cursor to the position of the error message, double click, and jump to the editor.
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(9) The editor will be started.

The cursor is on the line containing the error.

Because variable ii is not defined in this program, an error occurs.

Correct the error and save the source file by selecting [File] → [Save] in the editor.
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(10)Select build once again.

(11)The build processing has been completed normally.

(12)Start the debugger and start debugging.
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CHAPTER  5   CONSTRAINTS

This chapter explains the constraints of the Project Manager.

(1) Limit values of project manager

Some items have limit values, such as the number of files that can be handled by the Project Manager.  These

items are also explained in the other parts of this manual.  Table 5-1 lists these items.

Figure 5-1.  Limit Values of Project Manager

Item Maximum Value

Number of registered source files 1022

Number of registered tool files 10

Size of memo 256 bytes

Number of registered memos 237

Tool DLLs that can be registered 10

Project file name 255 characters (12 characters max.

is recommended)

Project directory 246 characters (128 characters

max. is recommended)

Title of project 64 characters

Registered tool file name 128 characters

Registered tool tile 32 characters

Size of project file 64 KB

(2) About the editor

If the editor tab is selected in the <Project Manager Options> dialog box and “External Editor” is selected,

messages cannot be exchanged between the Project Manager and the editor.  In this state, the [Build and

debug] menu is dimmed and cannot be selected.  Nor can the source be corrected from the debugger.
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CHAPTER  6   DEVICE  FILE  INSTALLER  (DFINST)

6.1   Product Overview

6.1.1   Overview

The device file installer registers a “device file”, which is necessary for developing and debugging programs, in the

registry.

A device file installer is supplied with the project manager, ID78Kx, and SM78Kx.  When each of these programs

is installed, the installer is also installed.

[Caution]

If NECDEV.INI does not exist and if no tools are registered in the registry, this program displays the message box

shown in Figure 6-1 and is terminated.  Before using a device file, install a 32-bit product.

Figure 6-1.  Error on Start-up

6.1.2   Major functions

The major functions of the device installer are as follows:

(1) Registers a device file existing on hard disk in the registry.

(2) Installs a device file product from a disk.

(3) Uninstalls device files.

(4) Changes the register directory.

(5) Transfers the device file information registered in a tool setting information file (NECDEV.INI) in an existing NEC

development tool environment (16-bit environment) to the registry for a 32-bit environment.

When the project manager is installed, the device file installer is started at the last stage of installation.  If an

existing NEC development tool environment (16-bit environment) is being used, the transfer processing is

automatically performed.

If the transfer processing does not work and must be manually performed, refer to 6.3.2  Moving device files.

6.1.3   Operating environment

The operating environment of the device file installer is guaranteed in the environment where the project manager,

ID78Kx, and SM78Kx runs.
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6.2   Starting and Exiting

6.2.1   Starting

When the icon in the project manager group registered during installation is clicked, the following screen is

displayed.  This is the main window of the device file installer.

Figure 6-2.  Main Window

System menu icon Close button

Source combo box

Source list view

Registry list box

Here is an explanation of each part of the main window:

(1) System menu icon

If this icon is clicked, the system menu is opened.

(2) Install button

Starts the Install Wizard and installs a device file from a device file product disk.

(3) Source combo box

Specifies the registration source of the device file.

(4) Browse button

Selects the directory of the registration source of the device file.  The selected directory name is added to the

source combo box.
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(5) Source list view

Displays the names of device files stored in the directory selected with the source combo box and device files

that are registered in NECDEV.INI.

(6) Move button

Registers device file information that exists in any directory and is registered in NECDEV.INI but not in the

registry, to the registry.  The contents of registry remain intact.

(7) Registration button

Registers the device file information that exists in any directory in the registry.

(8) Registration clear button

Clears the registration of the device file information registered in the registry.  The device file information whose

registration is cleared can be re-registered using the  Register  button.

(9) “Delete File” check box

If this check box is selected when a registration is removed, the device file is deleted from the hard disk.  If the

check box is clear, the device file is not deleted.

(10)Change registered directory button

Changes the directory of the device file registered currently.

(11)Registry list view

Displays the device names registered in the registry of a list of device file names.

(12)Help button

Opens a help file in the device file installer.

(13)About button

Displays the version of the device file installer.

(14)Exit button

Terminates the device file installer.

The initial status of the main window when this program has been started is as follows:
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Table 6-1.  Initial Status of Main Window on Start-up

Item Initial Status

Focus Install button

Install button Valid

Source combo box NECDEV.INI is selected.

Browse button Valid

Source list view Displays device names registered in NECDEV.INI but not registered in registry.

All device names are in selected status.

Move button Valid if even only one device is displayed

Registration button Invalid

Registration clear button Invalid

“Delete File” check box Cleared

Change registered directory

button

Valid if even only one device name is registered

Registry list view Displays device names registered in registry.

All device names are not selected.

Help button Valid

About button Valid

Exit button Valid

6.2.2   Exiting

Exit from the device file installer in the following three ways:

<1> Click the  Exit  button in the main window.

<2> Click the icon in the top left of the main window, open the system menu, and select [Close] menu.

<3> Click the icon (close button) at the top right of the main window.
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6.3   Installing Device Files

To install a new device file, click the  Install...  button.

To use a device file used with the old version (16-bit environment) in the 32-bit environment, use the  Register

and  Move  buttons.

The difference between “Register” and “Move” is that “Register” registers the device file information in any

directory in the registry, while “Move” registers the device file that exists in any directory and is registered in the tool

setting information file (NECDEV.INI) of a 16-bit environment, in the registry.

“Register” and “Move” are explained in detail below.

6.3.1   Registering device files

Register a device file information that exists in any directory in the registry.

The sequence of registration is explained below.

(1) Specify the registration source of the device file in the source combo box.

A device file directory registered in NECDEV.INI or the registry can be selected and a list of device files that exist

is displayed in the source list view.

Figure 6-3.  Source Combo Box

To select a device file that exists in any other directory, click the  Browse...  button and select a directory.  The

selected directory is added to the source combo box, and the contents of the directory are displayed in the source list

view.  The added directory name is initialized each time the device file installer has been started.

To “Register”, select a directory other than NECDEV.INI.
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Figure 6-4.  Browsing a Folder (When Registering)

(2) Select the device file name to be registered in the registry, from the source list view.

Of the device files that exist in the device file directory selected in the source combo box, the device file names

that have not been registered in the registry are displayed in the source list view.

If one or more device names is selected, the  Register  button becomes valid, and the  Move  and  UnRegister

buttons become invalid.

Figure 6-5.  Source List View (Device File Directory Display)
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(3) If the  Register  button is clicked or if a device name is selected from the list view and double-clicked, the

following confirmation message is displayed.

If the  OK  button is clicked, registration processing is executed.  If the  Cancel  button is pressed, nothing is

performed and the original screen is displayed again.

Figure 6-6.  Confirmation of Registration

If the series to be registered exists in a directory other than the registered device file directory, the following

confirmation message box is displayed.

If the  OK  button is pressed, the series to be registered is copied to the registered directory.

If the  Cancel  button is pressed, nothing is performed and the original screen is displayed again.

Figure 6-7.  Confirmation If Registration Directory Differs

If a file of the same name already exists in the registry, the following confirmation dialog box is displayed.  The

data version in the device file is used to identify the versions of common device files.  For other device files, the time

stamp of the file is employed.



CHAPTER  6   DEVICE  FILE  INSTALLER  (DFINST)

User’s Manual  U15636EJ1V0UM 101

Figure 6-8.  If Same or Newer Version of File Exists

Figure 6-9.  If Old Version of File Exists

<1> “OverWrite Setting”

Newer version only: Overwrites only if the copied version is new.

Overwrite Always: Overwrites, ignoring the version.

Not overwrite: Does not overwrite.

<2> “Remaining Setting”

Ask every file: If multiple files are processed, this dialog box is also displayed when the next file and

those that follow are processed.

Same setting: If multiple files are processed, the next file and those that follow are automatically

processed by the method specified in “OverWrite Setting”.
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<3>  OK  button: Executes the processing with the settings specified in the dialog box.

<4>  Cancel  button: Stops all processing.  The files that have been copied before the  Cancel  button is

pressed remain unchanged.

If the contents of the device file to be registered are not correct, the following message box is displayed.

If the  OK  button is pressed, the device file to be registered is not registered, and processing of the next selected

device file is started.  If the  Cancel  button is pressed, the registration processing is stopped.

Figure 6-10.  Illegal Device File Message

If an error occurs during copying, the following error message is displayed.

If the  OK  button is pressed, the registration processing is stopped.

Figure 6-11.  Copy Error During Registration
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6.3.2   Moving device files

Registers the device files that are registered in NECDEV.INI, but are not registered in the registry, in the registry.

The registered contents of NECDEV.INI remain as they are.

This move processing is usually performed automatically when the project manager is installed.  If it is not

performed correctly, perform the move processing manually following the procedure explained in this section.

The procedure for registration is as follows:

(1) Select NECDEV.INI in the source combo box.

(2) Select a device file name to be registered in the registry, in the source list view.

Of the device files registered in NECDEV.INI, the device names that are not registered in the registry are

displayed in the source list view.  If NECDEV.INI does not exist, nothing is displayed in the list view.

The display format is “series name - device name”.

If one or more device name is selected, the  Move  button becomes valid, and the  Register  and  UnRegister

buttons become invalid.

Figure 6-12.  Source List View (NECDEV.INI Display)
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(3) Click the  Move  button or double-click the device name in the list view.  The following confirmation message will

be displayed.

If the  OK  button is pressed, the transfer processing is executed.  If the  Cancel  button is pressed, nothing is

executed and the original screen is displayed.

Figure 6-13.  Confirmation of Move

If a file to be moved does not exist, the following message box is displayed.

If the  OK  button is pressed, the device file to be moved, is not moved, and the processing of the next device to

be selected is started.  If the  Cancel  button is pressed, the move processing is stopped.

Figure 6-14.  If There Is No File to Be Moved

If an error occurs during copying, the following message box is displayed.

If the  OK  button is pressed, the move processing is stopped.

Figure 6-15.  If Copy Error Occurs During Move
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Caution If the series to be moved exist in a directory different from the device file directory registered in

the registry, the confirmation message box is not displayed, and the device file is copied to the

registered directory.

6.3.3   Installing a new device file

[Overview]

Install a device file from a device file product disk or directory that contains a device file product.  The device file

information is registered in the registry.

By specifying “install information file (NECSETUP.INI)” included in the device file product disk, this program

carries out the install process in accordance with that information.

Note that the disk to which the file is installed must have at least 1MB of free space.

(1) Specifying install information file

Specify an install information file.

Figure 6-16.  Specifying Install Information File

Initially the install information file name is blank, and the  <Back  and  Next>  buttons are invalid.

When a file name is input, the  Next>  button becomes valid.  The  <Back  button is always invalid.

Open the <Open> dialog box by using the  Browse  button.

The file types are “Install Information File (*.ini)” and “All files (*.*)”.

By using the  A:FD Browse...  button, directly select the floppy disk drive.
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The default directory is the directory in which this program exists.

When the  Next>  button is pressed, the conditions of use for the software included in the device file product is

displayed.

If the  Cancel  button is pressed, the install wizard is terminated and the main window is displayed again.

Figure 6-17.  NEC Software License Agreement

Press the  Agree  button to proceed.

If the  Don’t Agree  button is pressed, the previous screen is displayed.

If the specified install information file does not exist or if it is illegal when the  Next  button is pressed, the

following message box is displayed.  If the  OK  button is pressed, “Install Information File” is displayed again.

Figure 6-18.  If Install Information File Is Illegal
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(2) Selecting kind of file

Select the kinds of the products to be installed.

If only one product type is selected, this page is not displayed and the next page is displayed.

Figure 6-19.  Selecting Kind of File

A check box is displayed for each product.  All check boxes are selected by default.  Up to four check boxes can

be displayed.  The number of check boxes displayed is equal to the number of products.

Only one item can be selected from the radio buttons.  It is also possible to select none of the products.

Press the  <Back  button to return to the previous screen.

Press the  Next>  button to proceed to the next screen.  This is invalid when all the check boxes are OFF.

If the  Cancel  button is pressed, the install wizard is terminated and the main window is displayed again.
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(3) Specifying install directory

Specify the install directory of the common device file.

Figure 6-20.  Install Directory

The default install directory is the dev directory in the directory in which the tool is installed (e.g.,

C:\NECTools32).

If the install directory edit box is empty, the  Next>  button is invalid.

Press the  <Back  button to return to the previous screen.

Press the  Next>  button to proceed to the next screen.

If the  Cancel  button is pressed, the Install Wizard is terminated and the main window is displayed again.
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(4) Starting installation

The following screen is displayed to confirm the selected product types and their install directory.

Figure 6-21.  Installation Start

Press the  <Back  button to return to the previous screen.

If the  Next>  button is pressed, the actual installation is executed, and the next screen is displayed after

installation.

If the  Cancel  button is pressed, the Install Wizard is terminated and the main window is displayed again.

While copying is in progress, a dialog box indicating the progress is displayed.  To stop copying, press the

Cancel  button.

Figure 6-22.  Display During Copying
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If an error occurs during copying, the following message box is displayed.  If the OK button is pressed,

installation is terminated, and an abnormal termination message is displayed.

Figure 6-23.  Copy Error During Installation

(5) End of installation

When installation has been completed normally, the following screen is displayed.

Figure 6-24.  End of Installation (Normal Completion)

If the  Finish  or  Cancel  button is pressed, the Install Wizard is terminated, and the main window is displayed

again.
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If installation is terminated abnormally, the following screen is displayed.

Figure 6-25.  End of Installation (Abnormal Termination)

If the  Exit  or  Cancel  button is pressed, the Install Wizard is terminated, and the main window is displayed

again.

If installation has been stopped in the middle, the following screen is displayed.

Figure 6-26.  End of Installation (When Stopped)
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If the  Exit  or  Cancel  button is pressed, the Install Wizard is terminated, and the main window is displayed

again.

6.3.4   Clearing registration of device file

This clears the registration of a device file from the registry.

A device file whose registration has been cleared can be re-registered by using the  Register  button.

The procedure for clearing registration is explained below.

(1) Select a device file name whose registration is to be cleared, in the registry list box.

If one or more device files displayed in the registry list box are selected, the  UnRegister  button becomes valid;

otherwise, this button is invalid.

Figure 6-27.  Registry List Box

(2) When the  UnRegistry  button is clicked, the following confirmation message is displayed.

If the  OK  button is pressed, the registration is cleared.  If the  Cancel  button is pressed, nothing is performed

and the previous screen is displayed.

Figure 6-28.  Confirmation of Clearing Registration (1)
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If the “Delete File” check box is selected, the actual device file is also deleted from the disk.  In this case, the

device file cannot be registered again.

When the  UnRegister  button is clicked, the following confirmation message is displayed.

If the  OK  button is pressed, the registration is cleared.  If the  Cancel  button is pressed, nothing is performed

and the previous screen is displayed.

Figure 6-29.  Confirmation of Clearing Registration (2)

If the device file cannot be deleted, the following message box is displayed.

If the  OK  button is pressed, the device file is not deleted, and the processing proceeds to the next device file

selected.  If the  Cancel  button is pressed, the deletion processing is stopped.

Figure 6-30.  Deleting Device File
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6.3.5   Change of registered directory of device file

The currently registered device file directory can be changed.

The following shows the sequence of how to change a registered directory.

(1) Click the  Change registered directory…  button to display the <Change registered directory> dialog box

The  Change registered directory…  button is valid when a device file is registered, and is invalid when no device

file is registered.

Figure 6-31.  <Change Registered Directory> Dialog Box

(2) In the <Change registered directory> dialog box:

<1> Select a series name to be changed using the “Series:” combo box.

“All” and a list of series names registered in a registry are displayed in this box.  All registered series names

will be targeted when “All” is selected.  “All” is specified by default.

Figure 6-32.  “Series:” Combo Box

<2> Enter the changed directory in the “Directory:” edit box.

When the “Series:” combo box is changed, the current directory of the corresponding series is displayed by

default.  The default setting of “All” is [tool directory + “\DEV”].

Click the  Browse  button to display the <Browse for Folder> dialog box.  The directory selected here is

displayed in the “Directory:” edit box.
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Figure 6-33.  Browse for Folder (When Registered Directory Is Changed)

<3> Click the  OK  button to move all the device files of the series selected using the “Series:” combo box to the

directory specified in the “Directory:” edit box.  Registration of a registry is also changed at this time.

Even if a device file change results in making the source directory empty, the directory will not be deleted.

If no directory exists after a change, a new directory is created.

Click the  Cancel  button to return without any change.

If a file having the same name, a new version file, or an old version file already exits, the dialog boxes

shown in Figures 6-8 and 6-9 are display for confirmation.
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6.4   Tool Tip Help

If the cursor is placed over a control in the main window such as a combo box or button for about half a second, a

description of the control is displayed.

Figure 6-34.  Tool Tip Display

Table 6-2.  Contents of Tool Tips

Control Description

Install button Install from Device File Product DISK

Source combo box Select Install Source (NECDEV.INI or Device File Directry)

Browse button No description

Source list view No description

Move button Move from NECDEV.INI to Registry

Registration button Register Device File from directory to Registry

Registration clear button UnRegister from Registry

“Delete File” check box Delete file when UnRegister

Change registered directory button Change registered Device File Directory.

Registry list view If drop Device File, register it.

Help button Display online document contents.

About button Display program information, version number and copyright.

Exit button Exit Program
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APPENDIX  A   MESSAGE  LIST

A.1 Project Manager Messages

The caption on a message box output by the project manager is “Project Manager”.

The messages of the project manager are classified into the following four types:

(1) Abort

The project manager is terminated when the OK button is pressed.

A001 through A079:  Messages output by the project manager body.

A080 through A099:  Messages output by PRJTMAKE.

(2) Fatal

Pressing the OK button restores the project manager.

F101 through F299:  Messages output by the project manager body.

F300 through F499:  Messages output by PRJTMAKE.

(3) Question

Must be selected.

Q501 through Q599:  Messages output by the project manager body.

Q601 through Q699:  Messages output by PRJTMAKE.

(4) Information

Pressing the OK button restores the project manager.

I701 through I799:  Messages output by the project manager body.

I801 through I899:  Messages output by PRJTMAKE.

Caption

Message
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A.1.1 Abort messages

Table A-1.  Abort Messages

Number Message and Description

Message Cannot find Project Manager information in the Registry. Closing the Project Manager.A001

Cause Information required by the project manager is not registered in the registry.  Re-install the project

manager.

Message Not enough memory.A002

Cause The memory capacity is not sufficient for executing the project manager.  Close any unnecessary

applications that are taking up memory.  Increase the free space on the disk by deleting

unnecessary files.

Message The version of the Project Manager registered in the Registry is illegal. Reinstall the Project

Manager. Closing the Project Manager.

A003

Cause The version number in the registry does not match the version number of the project manager.

Re-install the project manager.

Message There are no series sections. Closing the Project Manager.A004

Cause A section in which series information is stored is not registered in the registry.  Re-install the

project manager, and correctly set the registry.

Message Faild to read the Registry. Closing the Project Manager.A005

Cause A series section name could not be read from the registry.  Re-install the project manager.

Message The Project Manager directory registered in the Registry is illegal. Closing the Project Manager.A006

Cause The project manager directory in the registry is wrong.  Re-install the project manager.

Message The Project Manager Help directory in the Registry is illegal. Closing the Project Manager.A007

Cause The help directory setting for the project manager in the registry is incorrect.  Re-install the

project manager.

Message The Project Manager is already running.A008

Cause An attempt has been made to start the project manager more than once.  Use the project

manager that has already been started.
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A.1.2 Fatal messages

Table A-2.  Fatal Messages (1/5)

Number Message and Description

Message Cannot find the path or file. Make sure the path or file name is correct.F101

Cause The specified path or file cannot be found.  Specify a path or file that exists.

Message The directory name is illegal. Enter the correct directory name.F102

Cause The specified directory name does not exist or is illegal.  Specify a correct directory name.

Message The path or file name is illegal. Enter the correct path or file name.F103

Cause The specified path or file name is illegal.  Specify a correct path or file name.

Message The file extension is not prj.F104

Cause The extension of the specified project file is other than “.PRJ”.  Specify “.PRJ” as the extension of

the project file.

Message File name not specified. Please enter a file name.F105

Cause A file name was not input where a file name must be specified.  Input a file name.

Message Cannot print the project information.F106

Cause Either the printer driver is not set correctly, or the settings of the printer are illegal.  Check to see

if the printer driver is set.  Also check to see if the correct printer is connected.

Message No Help item.F107

Cause The help file is illegal.  Use a correct help file.

Message The file already exists.F108

Cause The specified path has been already set.  Change the name of the path, and set it again.

Message The title is already in use.F109

Cause The specified title has been already set.  Change the name of the title, and set it again.

Message Cannot execute. Make sure the path or file name is correct.F110

Cause A tool cannot be executed due to the status of the system, such as insufficient memory.  Check

the settings of the system.

Message Cannot access the drive. Make sure the drive is ready.F111

Cause The drive cannot be accessed because it is not ready.  Get the drive ready.

Message Failed to write the file.F112

Cause Writing to a file failed because:

• There is insufficient free space on the disk.

• The size of the file is 64K bytes or more.

• A write-protected file has been accessed.

Check the file and take following corrective action:

• Increase free space on the disk by deleting unnecessary files.

• Decrease the size of the file by deleting unnecessary data.

• Change the attributes of the file, or save it to another file.

Message Cannot create a path.F113

Cause A path cannot be created.  Check to see if the path is illegal, if the path name is too long, and if

there is enough free space on the disk.
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Table A-2.  Fatal Messages (2/5)

Number Message and Description

Message Cannot create the file.F114

Cause Creating a file has failed because:

• There is insufficient free space on the disk.

• A write-protected disk has been accessed.

Check the file and take following corrective action:

• Increase free space on the disk by deleting unnecessary files.

• Enable disk drive to be written to.

Message Series name not selected.F115

Cause  “OK” was selected but “series name” was not selected when project was set.  Select “OK” after

selecting “series name”.

Message Device name not selected.F116

Cause  “OK” was selected but “device name” was not selected when project was set.  Select “OK” after

selecting “device name”.

Message Editor not specified in the series information.F117

Cause Editor is not registered in series information.  Add information about editor to series information.

Message The version of the project file is illegal. Reading of project file terminated.F118

Cause The version number in the project file does not match the version number of project manager.

Re-create the project file.

Message Failed to load the tool DLL.F119

Cause A tool DLL could not be loaded into memory.  Confirm whether the path of the tool DLL in the

registry is correct, or re-install the series.

Message Failed to load the standard editor.F120

Cause The standard editor could not be loaded into memory.

Check to see if the path of the standard editor set by a project manager option is correct.  Or, re-

install the series.

Message Failed to load the debugger DLL.F121

Cause A tool DLL for the debugger could not be loaded to memory.  Check to see if the path of the tool

DLL in the registry is correct, or re-install the series.

Message Cannot find the series section name.F122

Cause Series information is not registered in the registry.  Re-install the project manager and correctly

set the registry.

Message Cannot find the series information.F123

Cause Information on the series is not registered in the series section of the registry.  Re-install the

project manager and correctly set the registry.

Message Cannot find the device name or device file name.F124

Cause Device information is not registered in the device file section of the registry.  Re-install the project

manager, and correctly set the registry.

Message The number of series sections in the Registry is different from the number of series names.F125

Cause The number of series section name entries, and the number actually registered differ.  Re-install

the tool.
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Table A-2.  Fatal Messages (3/5)

Number Message and Description

Message The number of series sections in the Registry is different from the number of device sections.F126

Cause The number of series sections and number of device sections differ.  Re-install the tool.

Message A path cannot be entered in the File Name textbox.F127

Cause A drive or directory is specified as the project file name in the <Project Setup> dialog.  Specify a

drive and directory name in the project directory.

Message Some source files cannot be registered.F128

Cause Either the source file registered in the project has been deleted, or a source file of the same

name has been registered.  Re-create the source file.

Message Some tools cannot be registered.F129

Cause The tool registered in [Tools...] is not registered on the disk.  Redo [Tools...].

Message Internal error.F130

Cause An error was detected during internal processing.

Inform NEC of the operating conditions.

Message The settable options have not been registered.F133

Cause There is no option for the source file selected in the project window.

Message Dependency scan or make file creation failed.F134

Cause Scanning a dependency relation or creating a make file failed for some reason.  Check to see if

the disk is in the status in which a file cannot be created (e.g., if 64K is exceeded in the case of

Win95), or if there is insufficient memory.

Message Failed to read the make file.F135

Cause The make file could not be read for some reason while the <Project Setup> dialog is displayed.

Check to see if the disk is in the status in which it cannot be read, or if there is insufficient

memory.

Message Cannot find the device file.F136

Cause A registered device file cannot be found.  Re-install the device file.

Message The file name of the standard editor has not been entered. Please enter the file name.F137

Cause A standard editor file name was not input in the dialog displayed by [Project Manager Options...].

Input a standard editor file name, or select another editor.

Message The file name of the editor has not been entered. Please enter the file name.F138

Cause An editor file name was not input in the dialog displayed by [Project Manager Options...].  Input a

editor name, or select another editor.

Message Cannot create the temporary file.F139

Cause A work temporary file could not be created.  Check to see if the disk is in a status in which a file

cannot be created, or if there is insufficient memory.

Message Failed to read the temporary file.F140

Cause A temporary work file could not be read.  Check to see if the disk is in a status in which it cannot

be read, or if there is insufficient memory.

Message Not enough disk space.F142

Cause A file could not be created because there is insufficient free space on the disk.  Confirm the

remaining free space on the disk.
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Table A-2.  Fatal Messages (4/5)

Number Message and Description

Message Too many source files.F143

Cause The number of read source files has reached 1,023.  Keep the number of source files to within

1,022 and create the project again.

Message The file extension is illegal.F144

Cause Because a tool that can process files with the specified extension does not exist, the file cannot

be registered in the project.  Check to see if the file extension is correct.

Message User program is running. Please stop program execution to select [Build]-[debug] command.F145

Cause When the [Build] → [Build and Debug] or [Build] → [Debug] command was executed, the load

module file could not be downloaded because a user program was running on the debugger.

Stop the user program on the debugger, and then execute the [Build] → [Debug] command.

Message Cannot execute this command while the debugger executing. Please execute it after exiting the

debugger.

F146

Cause When an attempt was made to execute the [New], [Open…], [Save As…], or [n Project name]

command, the command could not be executed because the debugger was being executed.  Exit

the debugger, and then execute the command again.

Message Cannot exit Project Manager while make file creating.F147

Cause An attempt was made to exit the Project Manager while creating a make file.  Exit the Project

Manager after creating a make file.

Message Cannot exit Project Manager while a build is in progress. Select the Stop Build command before

exit Project Manager.

F148

Cause An attempt was made to exit the Project Manager while build was in progress.  Exit the Project

Manager after completing or stopping the build.

Message Cannot convert to new path. Make sure the path is correct.F149

Cause The path of the project file copied from another folder could not be converted.  Make sure the

new path is correct that corresponds to the displayed folder or file name.

Message Failed to read the project file.F150

Cause An error occurred while reading the project file copied from another folder.  Check to see if the

project file is corrupted.

Message Cannot find the source file. \nAbort to compile.F151

Cause The source file to be compiled cannot be found.  Check to see if the specified source file exists.

Message The make file does not exist. Build aborted. Please create a make file.F301

Description The make file specified by the project manager does not exist.

Execute [Project] → [Make a Make File] in the project manager.

Message Syntax error. Please check the make file.  XXX Build aborted.F302

Description The contents of the make file are wrong.

Correct the make file.

Message Error detected on termination. Build abort.F303

Description An error was found when the command was terminated.

Check the contents of the build log file.

Check the contents of the make file.
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Table A-2.  Fatal Messages (5/5)

Number Message and Description

Message Can't keep enough memory to execute.F304

Description There is insufficient memory for build processing.

Close any unnecessary applications that are occupying the memory.

If Windows is used in the enhanced mode, delete unnecessary files to increase free space on the

disk.

Message System error occurred.F305

Description An internal processing error has been detected.

Inform NEC of the operating conditions.
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A.1.3 Question messages

Table A-3.  Question Messages

Number Message and Description

Message Starting build. Do you want to save the files currently being edited?Q501

Cause An attempt was made to execute build.  However, because editor is running, you are asked to

confirm whether build should be continued.

Message The file already exists. Do you want to use this file name?Q502

Description Because a file with the specified name already exists, confirmation is made whether processing

should continue with the specified file name.

Message The file already exists. Do you want to replace the file?Q503

Description Because the specified file already exists, confirmation is made whether the existing file is to be

overwritten.

Message The path does not exist. Do you want to create this path?Q505

Description Because the specified path does not exist, confirmation is made whether the specified path is to

be created.

Message The series information or options have changed. Do you want to rebuild?

Description Because the previous option has been changed when build is selected, confirmation is made

whether the specified path is to be created.

Q506

Description Confirmation is made whether the option should be changed to the debugging mode.

Message The file does not exist. Do you want to create it?Q509

Description Because the specified file is not registered on the disk, confirmation is made whether the file is to

be created.

Message The file name has changed. Do you want to add the specified file?Q510

Cause A source file name was selected when the source file tab in the <Project Setup> dialog was

selected, but an attempt has been made to cancel the source file name without adding it.

Message ×××  Project directory has changed. Do you want to cancel the source file setting?Q512

Cause The set source file is canceled because the project directory has been changed.

Message ×××  Target has been update. Rebuild?Q601

Description Because the target has been updated after the execution of the [Build] command, confirmation is

made whether to rebuild.

Message ×××  Target has been update. Rebuild?[NO] will startup the debugger without rebuilding.Q601

Description Because the target has been updated after the execution of the [Build and Debug] command,

confirmation is made whether to rebuild.
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A.1.4 Information messages

Table A-4.  Information Messages

Number Message and Description

Message Build completed normally.I801

Description Build processing has been completed normally.
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A.2 Status Bar Messages

A.2.1 Menu messages

Table A-5.  Menu Messages (1/2)

No. Message and Description

1 Message Move, Resize or Close Project Manager window.

2 Message Print, Printer setup, or Exit Project Manager.

3 Message Edit, Build, or Debug.

4 Message New, Open, Save, Save as, or Set project information.

5 Message Register tool, Option setting, Change debug mode, or Display status bar.

6 Message Display Help.

7 Message Print project information.

8 Message Close Project Manager.

9 Message Build and Debug.

10 Message Start editor.

11 Message Compile source file.

12 Message Start build.

13 Message Stop build.

14 Message Start debugger.

15 Message Rebuild.

16 Message Specify build setting.

17 Message Build a specified target.

18 Message Start a registered tool.

19 Message Create a new project.

20 Message Open a project file.

Status bar
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Table A-5.  Menu Messages (2/2)

No. Message and Description

21 Message Save project.

22 Message Save project with a new name.

23 Message Close project.

24 Message Specify project file name, title and device information.

25 Message Register source file.

26 Message Scan source file dependencies.

27 Message Specify memo.

28 Message Specify Project Manager options.

29 Message Read project file.

30 Message Register tool.

31 Message Start DeviceFile Installer.

32 Message Search help topics.

33 Message Display version of Project Manager.
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A.2.2 Messages on communication between programs

Table A-6.  Messages on Communication Between Programs

No. Message and Description

1 Message Creating make file.

2 Message Failed to create make file.

3 Message Make file created successfully.

4 Message Scanning source file dependencies.

5 Message Failed to scan source file dependencies.

6 Message Reading project file.

7 Message Saving project file.

8 Message Editor not registered.

9 Message Build tool not registered.

10 Message Not made a make file.

11 Message Debugger not registered.

12 Message Start build.

13 Message Stop build.

14 Message Start debugging.

15 Message Source editing process failed (processing cannot continue).

16 Message Source editing process failed (processing can continue).

17 Message Source editing process completed successfully.

18 Message Check whether editor is already being executed.

19 Message Check whether build is already being executed.

20 Message Check whether debugger is already being executed.

21 Message File editing completed.

22 Message File editing failed.

23 Message Build failed.

24 Message Make file contains syntax errors.

25 Message Build terminated before completion.

26 Message Build completed successfully.

27 Message Target is latest version.

28 Message Edit source file.

29 Message Moving a project.

30 Message Moving a project completed successfully.

31 Message Moving project failed.
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APPENDIX  B   MENU  LIST

Menu Mnemonic Meaning Page

[File] − − 27

Print… Ctrl + P Prints project information. 27

Exit − Terminates project manager. 29

[Build] − − 30

Build and Debug F5 Successively executes build and debugging. 30

Edit − Starts editor. 32

Compile Ctrl + F7 Executes language program on only one source file. 33

Build F7 Executes prjtmake. 35

Stop Build Ctrl + Break Stops build. 39

Debug − Starts debugger. 40

Rebuild − Forcibly executes build. 41

Build Option… − Settings related to build 42

<n Tool’s name> − Executes tool registered by user. 45

[Project] − − 46

New Ctrl + N Sets new project. 46

Open… Ctrl + O Opens project file. 50

Save Ctrl + S Saves information. 53

Save As… F12 Saves information to specified file. 54

Close – Closes project file. 56

Project Setup… − Sets project information. 57

Make a Make File Ctrl + M Creates make file. 64

<n Project name> − Starts project. 65

[Option] − − 66

<Tool’s name> − Sets tool options. 66

Tools… − Registers tools. 68

Project Manager

Options…

− Sets options of project manager and editor. 72

Device File Installer − Selects debugging or non-debugging mode. 77

[Help] − 78

PM Help Topics… − Searches topic of help. 78

About PM… − Version information of project manager 79
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APPENDIX  C   PROGRAMS  OF  PROJECT  MANAGER

File Name Description

prjman32.exe Project manager program

prjmak32.dll Analysis, execution of make file

prjman32.dll Management of messages in project manager

pm32spwn.exe Starting processes

prjman32.hlp Help file of project manager

readme.txt Text file for install

dfinst.exe Device file installer

dfinst.ini dfinst setting file

dfinst.hlp Help file of device file installer

ideal32.exe Standard editor idea-L of integrated development

environment

ideal32.hlp Help file for idea-L
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Project window .................................................18, 33, 73

Project window function ................................................80
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Register tool dialog box ................................................68
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Source correction ...................................................13, 93
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